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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty 
statements accompanying such products and services. Nothing herein should be construed as 
constituting an additional warranty. HP shall not be liable for technical or editorial errors or 
omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. 
Consistent with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software 
Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2006-2007 Hewlett-Packard Development Company, L.P.

This product includes i-net OPTA software, which is © Copyright 2002-2006 i-net software 
GmbH, Berlin, Germany.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

AMD is a trademark of Advanced Micro Devices, Inc.

HP-UX Release 11.00 and later (in both 32 and 64-bit configurations) on all HP 9000 
computers are Open Group UNIX 95 branded products.

Intel and Pentium are registered trademarks of Intel Corporation or its subsidiaries in the 
United States and other countries.

Java™ and all Java based trademarks and logos are trademarks or registered trademarks of 
Sun Microsystems, Inc. in the U.S. and other countries.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California.

UNIX® is a registered trademark of The Open Group.
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Support

You can visit the HP software support web site at:

http://www.hp.com/managementsoftware/support 

HP Software online support provides an efficient way to access interactive technical support 
tools. As a valued support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit enhancement requests online

• Download software patches

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Enter discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and log in. Many 
also require a support contract.

To find more information about access levels, go to:

http://www.hp.com/managementsoftware/access_level 

To register for an HP Passport ID, go to: 

http://www.managementsoftware.hp.com/passport-registration.html 
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Documentation Roadmap

Figure 1 on page 14 shows the documentation roadmap for HP Operations 
Dashboard. This roadmap presents a suggested order for reading the manuals 
available with HP Operations Dashboard:

1 Use the Installation Guide to install the product.

2 Follow the path for the HP Operations Dashboard component that you are 
using.

HP Operations Dashboard RealTime Health View

a Read the RealTime Health View Concepts Guide to understand the 
concepts of working with dashboards.

b Use the RealTime Health View Administrator Guide to configure and 
maintain the product.

c Reference the Smart Link integration guides as needed for specific 
details on the supported management product integrations.

HP Operations Dashboard Operations View

a Use the Operations View Quick Start Guide to carry out the tutorial.

b Read the “Essential Concepts” chapter of the Operations View 
Administrator Guide to understand the concepts of working with 
portlets and portal servers.

c Use the Operations View Administrator Guide to configure and 
maintain the product. This guide provides high-level instructions for 
the common tasks when working with the supplied Operations View 
portlets 

d If you are migrating from HP OpenView Service Information Portal to 
Operations View, use the Operations View Migration Guide to 
complete this task. The Operations View Administrator Guide refers 
you to the Operations View Migration Guide at the appropriate point 
in the portal view implementation process.

e Reference the integration guides as needed for specific details on each 
supported HP OpenView management product. The Operations View 
Administrator Guide refers you to the integration guides at the 
appropriate points in the portal view implementation process.
13



Figure 1 HP Operations Dashboard Documentation Roadmap
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HP Operations Dashboard Manuals

Table 1 describes the HP Operations Dashboard manual set. These documents 
are provided in Adobe Acrobat (.pdf) format and can be found in the following 
directories:

• After HP Operations Dashboard installation, in the following directory on 
the HP Operations Dashboard management station:

— Windows: <install_dir>\paperdocs\dashboard\

— UNIX: /opt/OV/paperdocs/dashboard/

• On the product DVD-ROM in the following directory:

— Windows: \Docs\

— UNIX: /Docs/

For information on how to obtain the most recent documents, see 
Documentation Updates on page 19.

Table 1 HP Operations Dashboard Documentation

Document Title and Filename Main Topics

Installation Guide
Installation.pdf

Installing, uninstalling, and upgrading 
HP Operations Dashboard

Migration Guide
Migration.pdf

• Overview of migrating from 
HP OpenView Service Information Portal 
(SIP) version 3.2 to Operations View

• SIP and Operations View comparison
• Migration use models
• Using the Operations View Migration 

Wizard
• Manual steps for migration
• Jetspeed user migration for RealTime 

Health View and Operations View
• Troubleshooting
15



RealTime Health View Concepts Guide
rhview/
RealTime_Health_View_Concept.pdf

• Introduction to the terms and concepts of 
RealTime Health View

RealTime Health View Administrator Guide
rhview/RealTime_Health_View_Admin.pdf

• Configuring RealTime Health View
• Maintaining RealTime Health View

Smart Link Integration for BMC Remedy 
Help Desk Installation Guide
RemedyOvSLI/Remedy_SLI_Install.pdf

Installing Smart Link Integration (SLI) for 
Remedy Help Desk

Operations View Quick Start Guide
opview/Quick_Start.pdf

• Running the Operations View 
demonstration portal view

• Operations View tutorial

Operations View Administrator Guide
opview/Administration.pdf

• Essential concepts
• Planning roadmap for using Operations 

View
• Connecting Operations View to 

management products
• Configuring Operations View portlets
• Configuring Operations View data filters
• Deploying a portlet application
• Troubleshooting

Operations View Integration Guide: NNM
opview/NNM_Integration.pdf

• Connecting Operations View to 
HP OpenView Network Node Manager 
(NNM)

• Configuring the NNM portlets
• Customizing the NNM portlets
• Filtering NNM data
• Troubleshooting

Table 1 HP Operations Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
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Operations View Integration Guide: OVO and 
OVSN
opview/OVO_OVSN_Integration.pdf

• Connecting Operations View to 
HP OpenView Operations (OVO) and 
HP OpenView Service Navigator (OVSN)

• Configuring the OVO and OVSN portlets
• Customizing the OVO and OVSN portlets
• Filtering OVO and OVSN data
• Troubleshooting

Operations View Integration Guide: OVIS
opview/OVIS_Integration.pdf

• Connecting Operations View to 
HP OpenView Internet Services (OVIS)

• Configuring the OVIS portlets
• Customizing the OVIS portlets
• Troubleshooting

Operations View Integration Guide: OVPM
opview/OVPM_Integration.pdf

• Connecting Operations View to 
HP OpenView Performance Manager 
(OVPM)

• Configuring the OVPM portlets
• Customizing the OVPM portlets
• Filtering OVPM data
• Troubleshooting

Operations View Integration Guide: OVSD, 
OVPI, and OVR
opview/OVSD_OVPI_OVR_Integration.pdf

• Connecting Operations View to 
HP OpenView Service Desk (OVSD), 
HP OpenView Performance Insight 
(OVPI), and HP OpenView Reporter 
(OVR)

• Configuring the OVSD, OVPI, and OVR 
portlets

• Customizing the OVSD, OVPI, and OVR 
portlets

• Troubleshooting

Table 1 HP Operations Dashboard Documentation (cont’d)

Document Title and Filename Main Topics
17



HP Operations Dashboard Online Help

HP Operations Dashboard  supplies the following graphical interfaces for 
portal and portlet configuration:

RealTime Health View

• HP Operations Dashboard Service Composer

Operations View

• Operations View Administrator Tool

• Operations View Migration Wizard (available from the Administrator 
Tool)

Each of the HP Operations Dashboard graphical interfaces includes online 
help files that explain that interface.

• To access the top level of the help content for each interface, use the 
commands on the Help menu.

• To access context-specific help information in the Operations View 
interfaces, click Help within the window for which you want more 
information.
18



Documentation Updates

This manual’s title page contains the following identifying information:

• Software version number, which indicates the software version

• Document release date, which changes each time the document is updated

• Software release date, which indicates the release date of this version of 
the software

To check for recent updates, or to verify that you are using the most recent 
edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the 
appropriate product support service. Contact your HP sales representative for 
details.
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Documentation Conventions

The HP Operations Dashboard documentation uses the following conventions:

Table 2 HP Operations Dashboard Documentation Conventions

Symbol Meaning

<install_dir> (Windows only.) The HP OpenView application directory. This 
directory contains all of the HP Operations Dashboard files. 
The default location is:
C:\Program Files\HP OpenView\

<data_dir> (Windows only.) The HP OpenView data directory. This 
directory contains product configuration and data files. The 
default location is:
C:\Program Files\HP OpenView\data

<portlet_app_dir> (Operations View only.) The top-level directory for a deployed 
portlet application. This directory has the same name as the 
portlet application. The location of this directory depends on the 
installation platform and the portal server.
• Jetspeed on Windows:

<install_dir>\nonOV\dashboard\jetspeed\2.1\webapps

• Jetspeed on UNIX:
/opt/OV/nonOV/dashboard/jetspeed/2.1/webapps

• BEA WebLogic on Windows (default):
<bea_install_dir>\user_projects\applications

• BEA WebLogic on UNIX (default):
<bea_install_dir>/user_projects/applications

<bea_install_dir> is the BEA WebLogic directory.

A note that describes special information pertaining to the 
current topic.

A tip that provides an alternate way to address the current 
topic.

A caution that indicates a potential problem to avoid.
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1 Introduction
HP Operations Dashboard Operations View provides portlets that collect and 
present information from many HP OpenView management products. A 
supported third-party portal server software product stores portal views that 
contain a mix of Operations View portlets and other portlets in order to 
provide an integrated  view of the management environment. Portal server 
users access the portal views with a web browser.

Use Operations View to give your end users visibility into their managed 
environments. You, the Operations View administrator, determine the content 
and layout of this information to ensure that each user receives an optimum 
view of their services. Additionally, you can customize data access to ensure 
that each user sees information about only those services that are applicable 
to them.

Operations View and Portal Servers

Operations View sits on top of a portal server to deliver management 
information to the end users. Operations View provides portlets that access 
the HP OpenView management products as well as a user interface for 
configuring these portlets. The portal server software product provides for 
setting up the portal views that contain Operations View portlets. It also 
provides for configuring and enforcing user access privileges.

The Operations View portlets are compliant with the JSR168 portlet 
standard. This release of Operations View supports the Apache Jetspeed and 
BEA WebLogic portal servers. Jetspeed is an open-source portal server and is 
supplied with Operations View. If you want to deploy to the BEA WebLogic 
portal server, you can purchase the BEA WebLogic Platform separately from 
your BEA reseller. For specific version requirements, refer to the Installation 
Guide.
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If you are not familiar with the process for configuring a portal with 
Operations View, walk through the Operations View tutorial in the 
Operations View Quick Start Guide to understand the integration between 
Operations View and the portal server software.

Operations View and RealTime Health View

The HP Operations Dashboard product consists of two components that can 
each be run stand-alone or in an integrated manner.

• RealTime Health View

• Operations View

RealTime Health View integrates management information from a variety of 
sources to create a complete high-level view of one or more services. When a 
problem is detected, a RealTime Health View operator can drill down from the 
high-level RealTime Health View into the product that serves as the source of 
the management data. RealTime Health View provides a simple drill-down 
capability into the management products. For a detailed drill-down view into 
HP OpenView management products, Operations View can be integrated into 
RealTime Health View such that drilling down into HP OpenView-sourced 
management data in RealTime Health View opens the appropriate Operations 
View portlet showing the specific data.
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User Interaction with Operations View

There are two categories of users who benefit from Operations View.

Administrators

Operations View administrators use the Administrator Tool to perform initial 
portlet configuration and on-going portlet maintenance. The Administrator 
Tool supports configuration of the following items:

• Connections between Operations View and management products

• Data filters

• Portlets

After configuring Operations View portlets, the administrator deploys the 
portlet application that contains those portlets to the portal server. The 
administrator then uses the portal server software tools to create and 
customize portal views and to set up user access to these portal views.

End Users

Operations View end users open a portal view containing Operations View 
portlets in a web browser. The portal server uses the portal view to organize 
content and layout. The portal server software manages user logins and 
displays the content assigned to a user’s access privileges.

Operations View end users need not be aware of the mechanics behind the 
portal creation and maintenance.
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About This Manual

This manual guides the Operations View administrator through the process of 
planning and implementing your Operations View portlets. It explains how to 
use the Administrator Tool. In doing so, this manual describes the following 
topics:

• The general process of configuring Operations View to connect to one or 
more HP OpenView management products.

• The general process of providing content through Operations View 
portlets.

• The general process of filtering management data.

• Complete instructions for customizing the bookmarks and message board 
portlets and how to use the HP OpenView Integration portlet.

Configuration of the portal view, users, and roles is a function of the portal 
server product. While this manual does not explain this configuration in 
detail, it does describe these functions as they fit into the process of 
developing a portal that includes Operations View portlets.

This manual does not explain the details of connecting Operations View to 
each HP OpenView management product. For this information, refer to the 
appropriate integration guide. The integration guides follow a standard 
content structure. After you are familiar with the organization of one 
integration guide, you can locate similar information about a different 
HP OpenView management product in a similarly named section in that 
product’s integration guide.

For information on the Operations View documentation set, see 
Documentation Roadmap on page 13.

This manual contains the following chapters:

• Essential Concepts explains the terms that are important when working 
with Operations View and portal servers.

• Planning Your Operations View Portal Content presents an overview of 
the process for implementing a portal view and lists questions to consider 
while you plan this implementation.

• Using the Operations View Administrator Tool explains how to start the 
Operations View Administrator Tool and gives some pointers for using 
this tool.
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• Configuring Operations View for Your Management Products describes 
the process of using the Administrator Tool to configure how Operations 
View will connect to management stations.

• Creating and Configuring Operations View Portlets describes the process 
of using the Administrator Tool to configure Operations View portlets.

• Configuring the Operations View Bookmarks Portlet describes 
functionality and configuration of the Operations View Bookmarks 
portlet.

• Configuring the Operations View Message Board Portlet describes 
functionality and configuration of the Operations View Message Board 
portlet.

• Configuring the Opeartions View SQL Portlet describes how to display 
data from the underlying configured database through a portal view.

• Configuring the Operations View Bookmarks Portlet describes the 
functionality and configuration of the HP OpenView Integration portlet.

• Configuring Operations View Data Filters describes the process of using 
the Administrator Tool to configure Operations View data filters.

• Deploying a Portlet Application describes the process of deploying an 
Operations View portlet application to a supported portal server.

• Configuring Operations View to Run in a Wireless Environment describes 
various Operations View portlets that are supported in wireless 
environment.

• Troubleshooting provides information for troubleshooting your Operations 
View portlets.

• Operations View Portlets lists the portlets that are supplied with the 
Operations View product.

• Portal View Planning Worksheets contains worksheets that you can use to 
organize and record the decisions that you make while planning your 
portal view implementation.

• HP OpenView Integration Portlet DTD describes the XML syntax for 
configuring the HP OpenView Integration portlet.

• Tips for Working with Jetspeed 2.1.1 and BEA WebLogic 8.1 contains 
some tips and tricks for working with the Jetspeed portal server and BEA 
WebLogic portal server software.
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2 Essential Concepts
This chapter explains the terms that are important when working with 
HP Operations Dashboard Operations View and portal servers. These terms 
are organized into the following categories:

• Portal Hierarchy on page 28

• Portal and Data Security on page 34

• Internationalization Model on page 38
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Portal Hierarchy

This section explains the terms specific to working with portals.

Portal

A portal is web site that functions as a starting place for users to access a 
range of services and aggregated content. Yahoo, Google, Lycos, and MSN are 
each an example of a portal.

Portal content is delivered in a web browser. This content can be customized 
per user. Portal content is displayed in portal views.

Operations View provides content that can be integrated into a portal.

Portal Server

A portal server is a computer that runs a portal server software product. The 
portal server software configuration includes the specification of users and 
roles that have access to a given portal view.

Operations View sits on top of a portal server to deliver management 
information to your end users. The portal server software product provides for 
setting up the portal views that contain Operations View portlets. It also 
provides for configuring and enforcing user access privileges.

This release of Operations View supports the Apache Jetspeed and BEA 
WebLogic portal servers. Jetspeed is an open-source portal server and is 
supplied with Operations View. If you want to deploy to the BEA WebLogic 
portal server, you can purchase the BEA WebLogic Platform separately from 
your BEA reseller. For specific version requirements, refer to the Installation 
Guide.
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JSR168

JSR168 is a portlet specification that provides for interoperability between 
portlets and portal servers. This specification also addresses how portal 
security and personalization are handled. The complete specification text is 
available at http://jcp.org/en/jsr/detail?id=168.

The Operations View portlets are JSR168-compliant and can be deployed into 
the supported portal server software products.

PSML

Portal Structure Markup Language (PSML) is an XML-based language that 
allows content structure and abstraction within Jetspeed. It is defined by an 
XML schema that is available at http://portals.apache.org/jetspeed-2/
guides/guide-psml.html. The layout of a portal view is defined in PSML.

Operations View does not interact directly with PSML files. Portal server 
administrators and users often work with PSML files.

Portal View

A portal view is displayed to an end user in a web browser. It consists of one or 
more pages that each contain one or more portlets. It is also a configured set of 
portal view attributes such as portal skin, portal header, portal footer, and so 
forth. Portal views are configured by using the portal server software tools.

Figure 2 on page 31 shows the typical components of a portal view.

The portal server software products that Operations View supports vary in 
their implementation of portlet preferences (such as changing which 
management station supplies the data to this portlet).

• With Jetspeed, all users who share a portal view (a PSML page) see the 
same user customizations to portlet preferences. If your users need to be 
able to customize their portlets without regard to other users, you create 
multiple copies of your portal views in order to provide this flexibility.

• With BEA WebLogic, each portlet user can customize portlet preferences 
without regard to other portlet users.
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The portal view design features that are available to you depend on which 
portal server product you are using. For information on the available features, 
see the documentation that came with your portal server.

Operations View supplies portlets that integrate with HP OpenView 
management products to display management data. All other components of a 
portal view come from the portal server software product.

Header and Footer

The header and footer can customize the portal view appearance. Operations 
View supplies several standard headers and footers. You can also design your 
own.

Navigation Aid

Navigation aids provide for movement between pages. They can appear as 
tabs along the top of the pages or as links along the side of the pages. Portal 
view users can customize the appearance of navigation aids.

Page

Each page in a portal view contains one or more portlets that display content 
to a user. The portal server software tools allow you to set the default page 
that is visible when the portal view first opens.

In Jetspeed, each portal view is configured in a PSML file.
In BEA WebLogic, a portal view is called a “desktop.”
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Figure 2 Components of a Portal View
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Portlet Application

A portlet application is a group of JSR 168-compliant portlets combined with 
functionality that is specific to the target portal server product. A portlet 
application is packaged in a web archive (WAR) file and viewed through its 
portlets. It is the portlet application that is deployed to the portal server so 
that its contained portlets can be used within a portal view.

Portlet

A portlet is the presentation layer for a portlet application. It is a Java-based 
web component that processes requests and generates dynamic content. This 
content is visible in a rectangular area on a portal page. Portlets packaged 
together in a single WAR file may share images, stylesheets, JSP components, 
and other kinds of resources.

Operations View provides portlets that access HP OpenView management 
products to display management data. Operations View also provides a user 
interface for configuring these portlets. Appendix A, Operations View Portlets 
lists the Operations View-supplied portlets and the HP OpenView 
management products with which they integrate.

Two important aspects of portlet configuration are portlet initialization 
parameters and portlet preferences.

Portlet Initialization Parameter

A portlet initialization parameter is a configuration setting that is used by the 
portlet as it is first instantiated. A portlet initialization parameter can be set 
to only one value.

End users cannot set portlet initialization parameters. Every instance of a 
portlet uses the same initialization parameter values.

In Operations View, portlet initialization parameters are set in the 
Operations View Administrator Tool and cannot be changed by portal view 
users.

Jetspeed uses the portlet application terminology.
In BEA WebLogic, a portlet application is called a “portal project.”
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Portlet Preference

Portlet preferences store portlet configuration data. A portlet preference can 
be set to a list of values.

Each portlet preference can be configured on a per user basis. Thus, when a 
user has edit permission for a portlet, they can customize the portlet view or 
behavior as desired.

In Operations View, portlet preferences are set when a portlet is added to a 
portlet application using the Administrator Tool. The Operations View 
administrator can then adjust the default portlet preference configurations for 
all end users.

The Operations View administrator can allow end users to modify portlet 
preferences within a portlet view. This modification creates a customization 
file that is managed by the portal server software product.

• With the Jetspeed portal server, all users who share a portal view (PSML 
file) see the same customizations.

• With the BEA WebLogic portal server, any logged in user sees only his or 
her customizations, regardless of the portal view.

Some Operations View portlets use portlet preferences as a mechanism for 
filtering the data that is displayed in the portlet. These portlets are listed in 
Chapter 12, Configuring Operations View Data Filters.

If a user saves the portlet preferences within a portal view, that portlet will no 
longer be updated as you change the portlet preferences in the Administrator 
Tool. To reset a portlet’s configuration to use the defaults as maintained in the 
Administrator Tool, delete and re-add the portlet in the portal view.
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Portal and Data Security

Operations View works in conjunction with the portal server software to 
provide a secure environment for your management data through the 
mechanisms described in this section. 

Authentication and Authorization

Authentication is the process by which a user identifies and validates himself/
herself to the system. Logging into a system is one way that a user is 
authenticated.

Authorization is the granting of access privileges to an authenticated user. 
These access privileges determine what information the user can see and 
what actions the user can take while logged into the system.

The portal server software uses an authorization model that associates access 
privileges with roles. A role defines what a user can see and do through the 
portal at a particular point in time. By associating users with roles and 
assigning to each role what you want users in that role to be able to see and 
do, you achieve portal security.

Authentication and authorization are both managed through portal server 
software configuration. Each supported portal server product supplies several 
authentication providers to choose from. If none of the supplied authentication 
providers meets your needs, you can write and integrate your own custom 
authentication provider. The supported portal servers provide APIs and 
sample code to write your own Java class to integrate with the portal server. 
For information on these APIs, go to:

• Jetspeed: http://portals.apache.org/jetspeed-2/guides/
guide-security.html

• BEA WebLogic: http://edocs.bea.com/wlp/docs81/adminportal/
help/OV_Security.html

If you have already configured roles on your portal server, you can use any 
combination of the existing roles and newly created roles for limiting access to 
the Operations View portlets.

BEA WebLogic uses the term “entitlements” for authorization.
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Users, Roles, and Groups

Users, roles, and groups are managed by the portal server software or by a 
third-party repository such as LDAP (lightweight directory access protocol). 
Each role defines a distinct grouping of users with different portal view access 
permissions, and each role can be associated with an unlimited number of 
management data filters. Each user can uniquely customize the look and feel 
of the portal view.

Data Filters

In Operations View, you filter management data with filter assignments and a 
customer model. This configuration is called data filtering. The data filter 
defines what data is displayed to a portal user who is using a given filter. 
Enabling filter assignments on a role-by-role basis provides data security, 
giving you a way to ensure that only relevant data is displayed to a given user.

Data filtering definitions are created in the Administrator Tool and consist of 
the following parts:

• Organization

• Customer model

• Filter assignment

The example in Figure 3 on page 37 shows how the data filtering definitions 
effect a limited view of the available data.

Organization

An organization is a logical grouping of management resources for use in filter 
assignments. Typically, an organization relates to a group of users in the 
portal and lists the resources that these users can access. When querying the 
management stations for data, Operations View displays only that data which 
is allowed for the organizations named in the current filter assignment.

The data filter concept is specific to Operations View.
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Customer Model

A customer model provides a way to ensure that data is displayed to the 
appropriate users. It is based on lists of resources, such as nodes, interfaces, or 
services. Customer models serve many functions and can be created in a 
variety of ways. A customer model can do one or both of the following:

• Map organizations to their resources, either by listing the resources 
directly in the file, or by referencing lists of resources.

• List the resources without any association to organizations.

Filter Assignment

A filter assignment maps organizations to a set of security constraints. This 
mapping limits the resources that a portal user can see. When a portlet refers 
to a data filter, it is commonly referring to a filter assignment. Within a filter 
assignment, two items are specified:

• The data to present through a view

You can set a filter assignment to show all data, show no data, or show 
data that is filtered based on a list of organizations that are defined within 
your customer model sources. Example filter assignments that show all 
data and no data are already provided with the default Operations View 
configuration.

• Which users see this filtered view

You can use filter assignments to allow access to the filtered views for 
different portal server roles. You can specify that all portal users have 
access to this filter, only authenticated users (that is users who have 
logged in), or users with any one of a list of portal roles.

The use of portal roles within filter assignments can vary from one portal 
server to another. Any portal sever that is JSR168-compliant must provide 
access to a mechanism for determining whether or not a user is within a role. 
For the Jetspeed portal, roles are a straightforward mechanism directly tied 
to the users. The BEA WebLogic portal includes additional role determination 
features that can utilize conditional logic.
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Figure 3 Operations View Data Filtering Example
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Internationalization Model

Operations View uses UTF-8 when communicating with the web browser and 
interpreting data in XML files. When getting data from management stations, 
Operations View converts from the native codeset (such as Shift JIS) used by 
the management station to Unicode. 

Figure 4 shows how the native codeset of the management data gets converted 
to Unicode and then displayed to the web browser in UTF-8 format.

Figure 4 Internationalization Model

What You Can Expect From Operations View

Operations View supports internationalization in the following ways:

• Installs under any language on any language system (such as Japanese 
versions of Windows).

• Uses locale-specific formats for date and time.

• Does locale-specific string comparison.

• Supports one web browser codeset—UTF-8.

• Provides localizable user interface and message strings.

This version of Operations View is not localized.
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• Displays the following types of localized data:

— Map data from HP OpenView Network Node Manager (NNM) 

— Customer names from HP OpenView Customer Views

— Data from HP OpenView Internet Services (OVIS)

— Data from HP OpenView Service Navigator (OVSN).

• Supports non-ASCII string data specific to Operations View that is in the 
UTF-8 codeset. This includes:

— Portlet titles specified in the portlet XML files

— Network Device Health gauge titles

— Alarm category names

— HP OpenView Integration portlet output data

— Message Board message text

— Bookmark link names

— Customer names in the Operations View customer model XML files

— Help files

• Supports ASCII string data only for:

— File and directory names

— URLs

Limitations

• Operations View does not ship the Java converters necessary to convert 
non-UTF-8 codeset data into UTF-8 codeset. Operations View assumes 
that these converters are part of the JRE on each platform.

• Operations View is only supported in a “mono-lingual” environment with 
all management stations in the same locale.
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3 Planning Your Operations View Portal 
Content
The goal of working with HP Operations Dashboard Operations View in 
combination with a portal server software product is to produce one or more 
portal views containing portlets. A portal view can include portlets from a 
variety of sources. Operations View portlets can retrieve information from 
HP OpenView management software in your environment. Additional portlets 
can display other types of information.

The actual process of implementing portal views is very flexible. Figure 5 on 
page 42 shows the sequence of high-level steps to create and deploy a portal 
view. As you can see, the sequence contains several possible opportunities 
(steps 1, 5, and 7) for designing a portal view. Generally, you will do most of 
your portal view design work in one of these design steps, skipping the other 
design steps.

Some best practices to consider before choosing when to do the portal view 
design work are listed here:

• If many people in your organization require input into the portal view 
design, plan the portal views before you begin to implement them.

• Generally, the more complex your portal view will be, the more design 
work you want to do up front because it is easier to change a paper design 
than a functioning portal view.

• If you are creating a small portal view for a very specific audience and you 
have a good understanding of the desired outcome, you can probably 
bypass the advanced planning and go straight to implementing the portlet 
configurations.

• If HP OpenView Service Information Portal (SIP) is currently installed in 
your environment see the note on page 44.
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Figure 5 Portal View Implementation Process
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Table 3 associates the tasks shown in Figure 5 with the related Operations 
View documentation. For more information on the available Operations View 
documentation, see Documentation Roadmap on page 13.

Table 3 Operations View Content Development Roadmap

Task Available Documentation

Design portal view This chapter

Migrate SIP 3.2 configuration (optional) Operations View Migration Guide

Reduce portlets (optional) Operations View Migration Guide

Configure management stations Chapter 5, Configuring Operations View for 
Your Management Products
Operations View product integration guides

Configure portlets Chapter 6, Creating and Configuring 
Operations View Portlets
Chapter 7, Configuring the Operations View 
Bookmarks Portlet
Chapter 8, Configuring the Operations View 
Message Board Portlet
Chapter 10, Configuring the HP OpenView 
Integration Portlet
Operations View product integration guides

Configure data filters Chapter 12, Configuring Operations View 
Data Filters in the Operations View 
Administrator Guide

Edit portlet configurations Chapter 6, Creating and Configuring 
Operations View Portlets
Operations View product integration guides

Deploy portlet application to portal server Chapter 11, Deploying a Portlet Application

Lay out portal view Portal server software product documentation

Test portal view Portal server software product documentation

Maintain portlet configurations Chapter 6, Creating and Configuring 
Operations View Portlets
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SIP customers:

If you are migrating a SIP version 3.2 configuration, have a good 
understanding of that configuration, and do not plan to change it, this chapter 
might not apply to you. In that case, you can start with migration.

Regardless of when you design the portal view, you should migrate your 
existing SIP configuration before doing any configuration work in the 
Operations View Administrator Tool. The migrated files overwrite some of the 
existing configuration files. Any changes that you make to management 
station and data filter configurations prior to migration will be lost. For more 
information, see the Operations View Migration Guide.
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Designing Your Portal View

Figure 6 shows the steps to complete portal view planning (step 1 in Figure 5 
on page 42).

• Steps 1 through 5 of Figure 6 are described in this chapter.

• Step 6 of Figure 6 corresponds to step 2 or 2m in Figure 5 on page 42.

Figure 6 Planning Steps for Designing your Portal View
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Portal View Planning Worksheets

The sections in this chapter reference the planning worksheets in Appendix B, 
Portal View Planning Worksheets. If you find these worksheets helpful, you 
can use them to record your design decisions and communicate your plan to 
your portal view customers.
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Planning Step 1: Select Portal Content

The first step in the planning process is to decide what data to display in your 
Operations View portal views. The following content types are available:

• Content from other HP OpenView products through the use of 
HP OpenView product portlets supplied with Operations View. For a list 
of available portlet types, see Appendix A, Operations View Portlets. For 
detailed information about the type of content each portlet displays, refer 
to the appropriate product integration guide.

• General content, such as links to bookmarks and messages displayed to 
your customers.

• Content from third-party integrations and from your own applications and 
data.

Third-party portlets can come from any trusted source. The following links 
are good starting places when looking for additional portlet content:

— Open source portlets: 
http://portlet-opensrc.sourceforge.net/ 

— BEA Portal Solutions Catalog: 
http://dev.bea.com/products/wlportal/psc/index.jsp

— Portlets bundled with the Apache Jetspeed portal server:
http://portals.apache.org/jetspeed-2/guides/index.html

• Content displayed through the HP OpenView Integration portlet. For 
information, see Chapter 10, Configuring the HP OpenView Integration 
Portlet.

HP does not support any third-party portlets.

These portlets are developed by third parties to BEA and may be 
specific to the BEA portal server.

These portlets are not all JSR168-compliant and may not be 
compatible with the supported version of Jetspeed. 
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Selecting Content from Supplied HP OpenView Product Portlets

While deciding which HP OpenView product portlets to include in your portal 
views, see the HP OpenView Product Integrations Planning Worksheet on 
page 162 and consider the following questions:

• What kind of information do you want to deliver or display to your 
customers?

• Of the HP OpenView integrations supplied with Operations View, which 
provide the kind of content you want to display to your users?

Selecting General Content

While deciding which general content portlets to include in your portal views, 
see the General Content Planning Worksheet on page 167 and consider the 
following questions:

• Do you want to provide your customers with links to useful web sites 
through the Operations View bookmarks portlet?

• Do you want to take advantage of the Operations View message board 
portlet to communicate with your customers?

Selecting Content That Integrates Your Own Applications and Data

While deciding what additional content you want to provide in a portal view 
that is not supplied with Operations View, see the Custom Applications and 
Data Planning Worksheet  on page 168 and consider whether the 
HP OpenView Integration portlet can meet your need. Possible content types 
are as follows:

• Content from a third-party integration. The worksheet includes several 
links to use when starting your search for existing JSR168-compliant 
portlets.

• Content from a URL. For example, if you have an HTML file on a different 
server or a CGI program or other web application, you can display the 
contents of the URL.

• Output from executable commands. For example, if you want to run a 
command, such as ping, or a command that generates results from a 
database, you can display the output of the command.
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• HTML from an external file. For example, if you have a report in an 
HTML file on the local machine or a tool that generates reports in the 
form of text, you can display those reports.

• XML transformed to a displayable format using XSLT.

• Embedded HTML. For example, if you have a static HTML file, you can 
display the HTML content.
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Planning Step 2: Identify Portal Roles

The second step in the planning process is to identify to whom you want to 
display data, and understand how to grant them authorization to the portal 
view. Authorization is a portal server configuration that associates access 
rights with roles.

While planning your portal server roles, see the Portal Server Roles Planning 
Worksheet on page 169 and consider the following questions:

• Who will be using the portal views? Customers? Organizations within a 
company? Business users, technical users, network operation center 
(NOC) users?

• Can you categorize the content you want to display based on groups of 
users, such as business users, technical users, NOC users, and so forth? 
Do you want to display some portlets to business users but not to technical 
users? For example, business users may be more interested in report 
portlets. Technical users may be more interested in portlets that display 
the details of network and service health.

• Can you identify distinct roles for your users? For example, operator role, 
customerABC administrator role, technical user role, business user role, 
and so forth.

• Do you want to make available an unauthenticated user who has access to 
a limited portal? With this user, you might, for example, allow visitors to 
view the Operations View Bookmarks and Message Board portlets for 
general information without letting them see real management data or be 
able to perform editing operations.
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Planning Step 3: Design Portal Views

The third step in the planning process is to design the portal views that will be 
used to present the Operations View portlets to your users. This configuration 
is completed on the portal server by using the tools supplied with the portal 
server software.

Your portal view design may dictate how many copies of each portlet are 
needed. For example, you might be able to use several management data 
filters in one portlet to control what data is displayed to various users, or you 
might want to create a separate portlet for each customer.

While planning your portal views, see the Portal View Layout Planning 
Worksheet on page 170 and consider the following questions:

• What portlets do you want to display to each identified role or group?

• What will you name the pages on which the portlets appear, and how will 
you organize the pages?

• Do your users need flexibility to edit the portlet preferences without 
regard to other users? If so, plan multiple copies of a given portlet type.

• Do you want to customize the portal look and feel by using your own 
graphic images in the portal banner and footer?

• Do you want to tailor the portal look and feel to individual customers?

• Are the supplied portal skins (color schemes and fonts) sufficient for your 
portal views, or do you want to create custom portal skins?
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Planning Step 4: Identify Data Filters

The fourth step in the planning process is to think about your customers and 
how to identify the management data that is relevant to them. The result of 
this planning is data filtering.

Table 4 shows which supplied portlets use the Operations View data filters, 
which use their own data filters, and which do no data filtering. The planning 
in this chapter concerns only those portlets that use the Operations View data 
filters.

Table 4 The Use of Data Filtering by Supplied Portlets

HP OpenView Management 
Software/ Portlets

Use the 
Operations 
View Data 
Filters

Use Their Own 
Data Filters

Do No Filtering 
of Management 
Data

NNM: Alarms, Topology Map, 
Network Device Health, and 
MPLS portlets

X

OVO/OVSN portlets X

OVIS: Internet Services and 
Internet Services Dashboard 
portlets

X

OVPM: Performance Manager 
Portlet

X X

OV Reporter portlets X

OVSD portlets X

OVPI portlets X

Message Board portlet X

Bookmarks portlet X
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Designating Customer Models

While planning your customer model, see the Customer Organizations 
Planning Worksheet on page 171 and consider the following questions:

• If you useHP OpenView Customer Views for HP OpenView Network Node 
Manager (NNM), do you want to use the customer model configured 
through Customer Views to display segmented NNM data in the 
Operations View portlets?

• If you do not use Customer Views for NNM, do you want to display 
segmented NNM data in the Operations View portlets? You can 
implement a customer model that retrieves resource data from the NNM 
object database and maps the resources to organizations.

• Besides NNM data, is there other data that you want to segment by nodes 
or interfaces?

• Do you want to display customer-segmented service information from 
HP OpenView Service Navigator? If so, you will need to implement a 
customer model that maps services to customers.

• Are you displaying data from products that have their own data filters, 
such as HP OpenView Internet Services and HP OpenView Service Desk?

• Do you have customer model data in another product or database that you 
want to import to the Operations View portlets? If so, you will need to 
create a custom customer model URL source.
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Designating Filter Assignments

The default portlet configuration for the HP OpenView product portlets is that 
any authenticated portal user can see all available portlet data. Anonymous 
users do not see any portlet data.

While planning your filter assignments, see the Filter Assignments Planning 
Worksheet on page 172 and consider the following questions:

• What is your policy regarding what data is visible to anonymous portal 
users? This policy determines your minimum filter assignments.

• Do you need to restrict access on a role-by-role basis to the data from the 
resources within an organization? If so, plan multiple filter assignments 
per organization.
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Planning Step 5: Select an Authentication Provider 
(Optional)

The fifth step in the planning process is to consider the mechanism by which 
portal server users will be authenticated. Authentication is the process by 
which users identify and validate themselves to the system.

While selecting an authentication provider for your portal server, see the 
Portal Server Authentication Planning Worksheet on page 174 and consider 
the following questions:

• Do you need to implement security? If anonymous access to your portal 
views is acceptable, then no authentication is necessary. All users see the 
same information and customizations.

• Do you want the portal server to perform the authentication? Most portal 
servers embed several authentication providers with user interfaces for 
security management. These providers offer basic security but might not 
be sufficient for your customers’ security requirements.

• Do you need to integrate with a large security system in your 
environment? An external security system can communicate to the portal 
server whether a user has been authenticated.

• If none of the supplied authentication providers meets your needs and you 
are not required to integrate with an existing security system, do you 
want to develop your own authentication provider?
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Next Steps

Evaluate your portal view plan. As a best practice, solicit customer feedback to 
determine whether it meets your users’ needs. If necessary, iterate through 
the planning process described in this chapter until you have a solid design 
ready for implementation.

After completing the portal view design, do the following tasks:

1 If you are migrating a SIP configuration, perform the migration before 
performing any new configuration work. For information on migration, see 
the Operations View Migration Guide.

2 Use the Operations View Administrator Tool to modify a migrated 
configuration or to begin implementing the portal view design. Go to 
Chapter 5, Configuring Operations View for Your Management Products.

3 Use the portal server software administration tools to configure users and 
roles.

4 (Optional.) Configure the selected user authentication mechanism.
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4 Using the Operations View 
Administrator Tool
The HP Operations Dashboard Operations View Administrator Tool assists 
you in setting up and maintaining the connections between Operations View 
and the supported HP OpenView management products listed in Appendix A, 
Operations View Portlets. The Administrator Tool also supports configuration 
and maintenance of the Operations View Bookmarks, Operations View 
Message Board, and HP OpenView Integration portlets.

The Administrator Tool is a very flexible and powerful tool. It provides many 
ways to accomplish the same task. The procedures included in this manual 
document one way of using the Administrator Tool to configure and 
administer your Operations View portlets. As you work with the tool, you will 
notice that many of the functions are available through buttons and all 
functions are available from the menu bar. Determine which method of 
accessing the functionality works best for you, and substitute that method in 
the procedures.

To avoid data corruption, only one instance of the Administrator Tool can run 
on a given Operations View server at a time.
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Setting the X Windows Server DISPLAY for the 
Administrator Tool (UNIX only)

Operations View relies on Java’s Abstract Windows Toolkit (AWT) to generate 
graphical images. On UNIX, the AWT requires the presence of a running X 
windows server.

For the Operations View Administrator Tool to run, the following must be 
true:

• The DISPLAY environment variable must be set to point to an active X 
server, preferably on the same system running Operations View.

• The X display referenced by Operations View must be open the entire time 
that Administrator Tool is running.

To set the DISPLAY variable, run the following command on the X server:

export DISPLAY=hostname:0.0
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Starting the Administrator Tool

To start the Administrator Tool, follow the procedure appropriate to your 
operating system:

• Windows:

As a user with administrative privileges, click Start→ Programs→ 
HP OpenView→ Dashboard→ Operations View→ Administrator Tool.

• UNIX:

a Set the DISPLAY variable:

In a terminal window on the X server, type:
export DISPLAY=hostname:0.0

b As user root, in a terminal window, type: /opt/OV/bin/
ovopviewadmingui
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Using the Administrator Tool

The Administrator Tool is a graphical interface for configuring the following 
elements of an Operations View portlet application:

• Management stations

• Customer models (data filters)

• Filter assignments

• HP OpenView Network Node Manager (NNM) alarm categories

• NNM network health categories

• NNM network health metrics

• NNM network health component groups

• HP OpenView Operations (OVO) message categories

• Bookmarks portlets

• Message board portlets

• Portlet applications

• Portlets

The Administrator Tool contains two panes:

• The scoping pane on the left that contains the hierarchical tree nodes for 
the Operations View configuration. A shortcut menu associated with each 
node provides access to the most common tasks for that node type.

• The editor pane on the right that displays the configuration for the node 
selected in the scoping pane. To modify a configuration, make the desired 
changes in the editor pane, and then click Save.

Within the Administrator Tool, the following conventions apply:

• An asterisk (*) in the scoping pane indicates an unsaved configuration.

• An asterisk (*) in the editor pane indicates a required field.

• In the portlet editor pane, field names in standard text indicate portlet 
initialization parameters.

• In the portlet editor pane, field names in bold indicate portlet preferences.
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Table 5 lists the commands that are available from the Administrator Tool 
menu bar.

Table 5 Administrator Tool Menu Commands

Command Description

File menu

New Provides access for creating new objects such as a management 
station, portlet application, or portlet.

Exit Shuts down the Administrator Tool.

Tools menu

Launch SIP 
3.2->Operations 
View Migration

Starts the Operations View Migration Wizard. The Create Migration 
Staging Portlet Application window prompts you for a portlet 
application name prior to performing the migration steps.

Select Log Level Allows you to set the log level for the Administrator Tool and 
Operations View portlets.

Set Maximum Log 
Size

Allows you to set the maximum size of Operations View log files 
before rolling.

Select Look and Feel Allows you to set the skin (also called look and feel) for the 
Administrator Tool.

Select Font Allows you to adjust the font size or font type used by the 
Administrator Tool.

Select Default Portal 
Server

Allows you to set the portal server that is selected in the Add New 
Portlet Application window.

Set Portlet 
Application WAR File

Allows you to set the portlet application WAR file that is used when 
creating a portlet application. The default WAR file for Operations 
View is:
• Windows: 

<install_dir>\newconfig\dashboard\opview\opview.war

• UNIX: /opt/OV/newconfig/dashboard/opview/opview.war
Using the Operations View Administrator Tool 61



HP Operations Dashboard Operations View Administrator Guide Version 2.10
Accessing Online Help

You can access the online help for the Administrator Tool in two different 
ways:

• To open the Administrator Tool online help volume at the introductory 
topic, click Help, and then click Help Contents.

• To see the help topic for a specific configuration page within the 
Administrator Tool, click Help at the bottom of that page.

Set Jetspeed's 
Tomcat Installation 
Directory

Allows you to set the location of the Tomcat web container into which 
an Apache Jetspeed portlet application is deployed. The default 
value for Operations View is:
• Windows: <install_dir>\nonOV\dashboard\jetspeed\2.1
• UNIX: /opt/OV/nonOV/dashboard/jetspeed/2.1

Set Jetspeed's Ports 
and Proxy Settings

Allows you to set the ports used by Jetspeed Tomcat and Hypersonic 
SQL database. Also allows you to set the Jetspeed proxy for your 
environment.

Help menu

Help Contents Opens the Administrator Tool online help.

Document Set Provides access the Operations View manuals.

License Status Displays the status of your Operations View license.

Obtain License Displays the AutoPass window in which you can apply for a new 
license.

ecare Support Displays information about the available online support for 
Operations View.

About Displays the software version of the product.

Table 5 Administrator Tool Menu Commands

Command Description
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5 Configuring Operations View for Your 
Management Products
Before you can view management data through any of the HP OpenView 
product integration portlets supplied with HP Operations Dashboard 
Operations View, you must configure connections between Operations View 
and your management stations. This configuration consists of synchronizing 
management product configurations and their corresponding management 
station configurations.

The information in this chapter applies to step 2 in the portal view 
implementation process shown in Figure 5 on page 42.

This chapter includes the following procedural topics:

• Configuring an HP OpenView Management Product on page 64 lists the 
HP OpenView products that require additional configuration before 
interacting with the Operations View portlets.

• Configuring a Management Station on page 65 explains how to add a 
management station to the Operations View configuration.
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Configuring an HP OpenView Management Product

Some management products must be configured to make their management 
data available to Operations View. This configuration takes place on the 
HP OpenView management station for the following products:

• HP OpenView Network Node Manager (NNM)

For detailed instructions on how to fully configure NNM management 
station communication with Operations View portlets, refer to the 
Operations View Integration Guide: NNM.

• HP OpenView Operations (OVO) and HP OpenView Service Navigator 
(OVSN)

For detailed instructions on how to fully configure OVO and OVSN 
management station communication with Operations View portlets, refer 
to the Operations View Integration Guide: OVO and OVSN.

• HP OpenView Interconnect (OVI)

For detailed instructions on how to fully configure OVI management 
station communication with Operations View portlets, refer to the 
Operations View Integration Guide: OVO and OVSN.

• HP OpenView Internet Services (OVIS)

For detailed instructions on how to fully configure OVIS management 
station communication with Operations View portlets, refer to the 
Operations View Integration Guide: OVIS.
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Configuring a Management Station

Identify to Operations View the computers that host HP OpenView 
management products and specify parameters for connecting to these 
products. This configuration takes place in the Operations View 
Administrator Tool. Operations View management station configuration 
applies to the following products.

• NNM

• OVO/OVSN

• OVIS

• HP OpenView Performance Manager (OVPM)

• OVI

To make Operations View aware of your HP OpenView management stations, 
follow these steps:

1 In the Administrator Tool, click File→ New→ Management Station.

2 In the Add New Management Station window, enter the fully qualified 
hostname of the server on which the management software is installed 
(for example, host.corp.com), and then click OK.

The new management station name appears selected in the Management 
Stations folder in the scoping pane, and the editor pane displays the 
configuration for the management station.

3 In the General Settings area of the editor pane, select the check box for 
each management software product installed on this host.

The corresponding tab becomes available.

The Operations View portlets for the following products identify the 
management station in the portlet configuration. For these products, bypass 
these instructions and go to Chapter 6, Creating and Configuring Operations 
View Portlets.

• HP OpenView Service Desk (OVSD)

• HP OpenView Performance Insight (OVPI)

• HP OpenView Reporter (OVR)
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4 On each available tab, set the connection information for that product.

Click Help if you need assistance with the configuration settings.

5 After supplying the information on all available tabs, click Save.
66 Chapter 5



Version 2.10 HP Operations Dashboard Operations View Administrator Guide
Next Steps

When the management stations are correctly configured in the Administrator 
Tool, go to Chapter 6, Creating and Configuring Operations View Portlets.
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6 Creating and Configuring Operations 
View Portlets
An HP Operations Dashboard Operations View portlet application contains 
one or more Operations View portlets. For a list of the available portlets, see 
Appendix A, Operations View Portlets. The information in this chapter applies 
to steps 3, 5, and 9 in the portal view implementation process shown in 
Figure 5 on page 42.

This chapter includes the following procedural topics:

• Setting the Portlet Application WAR File on page 70 explains how to 
choose the portlet application WAR file to use for a new portlet 
application.

• Creating a Portlet Application on page 71 explains how to create a new 
portlet application that contains portlets.

• Creating a Portlet on page 73 explains how to create a portlet.

• Configuring a Portlet on page 74 explains the general process for settings 
a portlet’s configuration.

• Adding and Customizing Portlet Help Topics on page 76 explains how to 
make your own help content visible to portal view users.

• Maintaining Portlet Configurations on page 78 explains important 
information about modifying the configuration of a deployed portlet.
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Setting the Portlet Application WAR File

A portlet application WAR file contains a portlet.xml file that describes the 
portlets that can be used in that portlet application. Operations View provides 
the following portlet application WAR files:

• opview.war: Contains all Operations View portlets except for the portlet 
included in the next WAR file. Use this file for Jetspeed portal server.

• opview_weblogic.war: Contains all Operations View portlets except for the 
portlet included in the next WAR file. Use this file for WebLogic portal 
server.

• opviewMPLS.war: Contains the HP OV NNM MPLS and HP OV NNM 
Dynamic View portlets. Use this file for Jetspeed portal server.

• opviewMPLS_weblogic.war: Contains the HP OV NNM MPLS and HP OV 
NNM Dynamic View portlets. Use this file for WebLogic portal server

The portlet application WAR file in use when a portlet application is created 
determines which portlets that portlet application can contain.

To set the portlet application WAR file, follow these steps:

1 In the Operations View Administrator Tool, click Tools→ Set Portlet 
Application WAR File.

2 In the Set Portlet Application WAR File window, click Browse, and then 
select the desired WAR file.
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Creating a Portlet Application

A portlet application is a collection of portlets that can be deployed to a portal 
server.

To create a new portlet application for containing Operations View portlets, 
follow these steps:

1 In the Operations View Administrator Tool, click File→ New→ Portlet 
Application.

2 In the Add New Portlet Application window, enter the following 
information:

• Portlet Application Name: The name that appears in the Portlet 
Applications folder in the scoping pane and in the portal server 
software tools. The portlet application name must be unique, start 
with a letter or underscore character, and consist of only 
alphanumeric and underscore characters.

• Description (optional): The description that appears in the editor pane 
for the portlet application.

• Portal Server Vendor: Select your portal server software product.

• Staging Directory: Leave the staging directory as is.

• Create Default Portlets check box: If you do not clear the Create 
Default Portlets check box, the new portlet application will contain 
one instance of each Operations View portlet type.

By default, the Create and Deploy a Portlet Application window presents 
an overview of the process for deploying portlet content to the selected 
portal server. You can disable this feature.

The new portlet application appears in the Portlet Applications folder in 
the scoping pane, and information about the portlet application appears in 
the editor pane:

• The Deployment Phase shows staging.

• The Staging Directory field displays the directory on the Operations 
View server that stores the portlet application configuration.

• The Portlet Configuration File field displays the location of the 
portlet.xml file. This file contains the portlet configurations for this 
portlet application. It is located within the staging directory.
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• The Portlet Application WAR File field lists the WAR file associated 
with the portlet application. This portlet application can contain only 
those portlet types that are included in the specified WAR file.

• The Total Portlet Count field specifies the number of portlets 
contained in the portlet application.

• If you selected the BEA WebLogic 8.1 portal server vendor, the BEA 
Portlets Directory field lists the location of the opview_portlets 
directory for this portlet application. This directory stores the *.portlet 
files that contain BEA WebLogic portlet definitions. These portlet 
definitions configure BEA WebLogic with your JSR168 portlets when 
you import the Operations View portlet application into the BEA 
WebLogic Workshop as a portal project.
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Creating a Portlet

Operations View provides many portlets for inclusion in your portal views. 
Use the Operations View Administrator Tool to configure and maintain these 
portlets. For a list of the available Operations View portlets, see Appendix A, 
Operations View Portlets.

For third-party portlets, use the configuration and maintenance tools supplied 
with each portlet. These portlets are not accessible from the Administrator 
Tool.

A portlet application can contain many portlets, including multiple instances 
of a given portlet type. An Operations View portlet application can contain 
Operations View portlets only.

To create an Operations View portlet, follow these steps:

1 In the Operations View Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application in the scoping pane and in the portal server software tools. 
The portlet name must be unique, start with a letter or underscore 
character, and consist of only alphanumeric and underscore 
characters.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view. Defaults to the portlet name.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Portlet Type: Select the Operations View portlet type from the list.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.
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Configuring a Portlet

Operations View portlets are configured with portlet initialization parameters 
and portlet preferences. Within the portlet editor pane of the Administrator 
Tool, the following conventions apply:

• Portlet initialization parameters are indicated by standard text. These 
values cannot be changed by portal view users. Each user of a given 
portlet always sees the same results of the portlet initialization 
parameters. For more information, see Portlet Initialization Parameter on 
page 32.

• Portlet preferences are indicated by bold text. These values specify the 
default portlet configuration. Portlet users might change these settings. 
For more information, see Portlet Preference on page 33.

To configure an Operations View portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, select the portlet to 
configure.

The configuration information for this portlet appears in the editor pane.

2 In the General Settings area of the editor pane, modify the default 
settings as desired:

• Portlet Name: The name of the portlet as it appears in the portlet 
application.

• Portlet Title: The name of the portlet as it appears in the portal server 
software tools and the portal view.

• Portlet Class: A setting that is internal to Operations View. You 
cannot change this value.

• Description (optional): The portlet description as it appears in the 
portal server software tools.

• Mime Type: A setting that is internal to Operations View. You cannot 
change this value.

• Portlet Modes: Each selected check box adds functionality to the 
portlet. Available portlet modes are as follows:

— VIEW: When the VIEW check box is selected, portal users can see 
this portlet.
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— EDIT: When the EDIT check box is selected, portal users can 
change the values of the portlet preferences for this portlet. If the 
user is logged in, these changes are maintained for subsequent 
sessions. If the user is not logged in, these changes apply to this 
session only.

— HELP: When the HELP check box is selected, portal users can 
access the online help page for this portlet.

3 In the Portlet Edit area of the editor pane, modify the default settings as 
necessary. For detailed information on each of these parameters, see the 
documentation for the portlet:

• For the Operations View Message Board portlet, see Chapter 8, 
Configuring the Operations View Message Board Portlet.

• For the Operations View Bookmarks portlet, see Chapter 7, 
Configuring the Operations View Bookmarks Portlet.

• For the HP OpenView Integration portlet, see Chapter 10, 
Configuring the HP OpenView Integration Portlet.

• For the HP Software SQL portlet, see Chapter 9, Configuring the 
Opeartions View SQL Portlet.

• For other Operations View portlets, see the integration guide for the 
HP OpenView management product.

4 Click Save.
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Adding and Customizing Portlet Help Topics

Operations View provides the capability to add your own help topic for any of 
the supplied portlets, including portlets based on the HP OpenView 
Integration portlet. You can provide a standard help topic for any portlet, and 
you can override the standard help topic with different help content for an 
individual portal view.

When the user clicks the help button on the portlet title bar, the portlet 
displays the specified HTML help file.

All portlets that are supplied with Operations View come with a default help 
topic. If you want to customize the help topic or add a new one (as you may for 
your own portlets based on the HP OpenView Integration portlet), you need to 
write the help topic, assign it as the default help topic (or a new topic that 
overrides the default help topic), and verify that the topic displays correctly.

Writing a Help Topic

1 Copy and rename any Operations View help topic file. The new file can 
have any name that makes sense to you. For the English locale, help files 
are stored with the application data on the portal server in the following 
directory:

• Windows: <portlet_app_dir>\C\help\

• UNIX: <portlet_app_dir>/C/help/

2 Write your help file content. Feel free to present a help page using the 
most appropriate style for the portlet, but follow these important 
guidelines:

• Follow the HTML format that you find in the other files in the help 
directory.

• Use valid HTML syntax that is supported by all web browsers.

• Write the help content for the entire portlet. Understand that users 
may not all see the same content depending on data and display 
filtering and whether users are permitted to edit the portlet.

• Use only ASCII or UTF-8 characters.
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Assigning a Topic as the Default Help Topic for a Portlet

1 In the scoping pane of the Administrator Tool, navigate to the appropriate 
portlet within the Portlet Applications folder.

2 In the Portlet Edit area of the editor pane, type the path and file name of 
the help topic. For the English locale, the path must start with /C/help/ 
to be relative to the portlet application directory on the portal server.

3 Click Save, and then verify that the help topic displays correctly.
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Maintaining Portlet Configurations

Use the Administrator Tool to modify the portlet configuration as necessary 
throughout the life of your Operations View portlets. These modifications flow 
to the portal view automatically as described here.

• Changes to the portlet initialization parameters affect that portlet in all 
portal views.

• Changes to the portlet preferences affect that portlet only if the portal 
view user has not customized the portlet configuration. For more 
information, see Portlet Preference on page 33.
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Next Steps

Complete the configuration of individual portlets:

• For information on configuring the Operations View Message Board 
portlet, see Chapter 8, Configuring the Operations View Message Board 
Portlet.

• For information on configuring the Operations View Bookmarks portlet, 
see Chapter 7, Configuring the Operations View Bookmarks Portlet.

• For information on configuring the HP OpenView Integration portlet, see 
Chapter 10, Configuring the HP OpenView Integration Portlet.

• For information on configuring the HP Software SQL Portlet, see Chapter 
9, Configuring the Opeartions View SQL Portlet.

• For information on configuring the HP OpenView product portlets, see the 
individual product integration guides.

When the Operations View portlets are correctly configured, go to Chapter 12, 
Configuring Operations View Data Filters.
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7 Configuring the Operations View 
Bookmarks Portlet
The HP Operations Dashboard Operations View Bookmarks portlet can 
provide lists of links to useful web sites.

This chapter describes the two aspects of using the bookmarks portlet:

• Manage bookmark group content within the Operations View Bookmark 
Groups folder in the Portlet Shared Configurations folder of the 
Administrator Tool. For information, see Managing Bookmark Content on 
page 82.

• Select bookmark groups for display and add individual bookmarks within 
the bookmark portlet(s) of your portlet application in the Portlet 
Applications folder of the Administrator Tool. For information, see 
Selecting Bookmarks to Display on page 85.
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Managing Bookmark Content

A bookmark group is a convenient way to manage lists of bookmarks. Each 
bookmark group can be assigned to one or more bookmarks portlets. When 
you change the bookmarks within a bookmark group, the bookmarks are 
automatically updated in all portlets that display that bookmark group.

In the Operations View Bookmark Groups folder of the Administrator Tool, 
you can do the following:

• Create new bookmark groups.

• Change the content of bookmark groups.

• Delete bookmark groups that no longer should be available for display in 
bookmarks portlets.

Creating a Bookmark Group

To create a bookmark group, follow these steps:

1 In the Administrator Tool, click File→ New→ Bookmarks Group.

2 In the Add New Bookmarks Group window, type the title and name of the 
new bookmark group.

• The bookmark group title appears in the Operations View Bookmark 
Groups folder in the scoping pane and in the Add Bookmarks Group 
list in the editor pane for the bookmarks portlets. The bookmark group 
title should be unique and may contain any characters.

• The bookmark group name is for internal use only. The bookmark 
group name must be unique, start with a letter, and consist of only 
alphanumeric characters.

The new bookmark group appears selected in the Operations View 
Bookmark Groups folder in the scoping pane, and the editor pane displays 
the empty bookmark group.
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3 Click Add Bookmark, and then, in the Add New Bookmark window, enter 
the following information:

• Bookmark URL: The URL link to the bookmark. The URL must 
include the protocol designation http://. For example, use http://
managementsoftware.hp.com instead of 
managementsoftware.hp.com.

• Bookmark Name: The name of the link as it is displayed to users 
through their bookmarks portlets.

• Window Name (optional): The name of the new window to create (or 
reuse) when opening the URL so that the current portal view window 
is not replaced. The value should contain no spaces.

4 Repeat Step 3 until you have added all bookmarks for this group.

5 After you have finished adding bookmarks to the group, click Save.

Modifying a Bookmark Group

To change the contents of a bookmark group, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet Shared 
Configurations folder, expand the Operations View Bookmark Groups 
folder, and then select the bookmark group to modify.

2 To add a bookmark to the group, in the editor pane click Add Bookmark, 
and then, in the Add New Bookmark window, enter the bookmark 
configuration. For information, see Step 3 on page 83.

3 To delete one or more bookmarks from the group:

a In the editor pane, select the bookmarks to delete, and then click 
Remove Bookmarks.

b In the Confirm Deletion window, read the message, and then click OK.
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Deleting a Bookmark Group

When you delete a bookmark group, you remove its association with the 
Operations View Bookmark Groups folder. You are not removing the contained 
bookmarks from the configuration of any portlets that use them, but those 
portlets can no longer use the deleted bookmarks.

Deleting a bookmark group from the Operations View Bookmark Groups 
folder has the following effects:

• If the group currently is not selected for display in a bookmarks portlet 
configuration, the group is no longer available to be selected for display.

• If the group currently is selected for display in a bookmarks portlet 
configuration, the group remains selected and the bookmarks portlets 
display the error message “Data Currently Unavailable” until you remove 
the group from the bookmarks portlet configuration or the user deletes the 
group in their portlet view.

To remove a bookmark group from use in the Operations View Bookmarks 
portlets, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet Shared 
Configurations folder, expand the Operations View Bookmark Groups 
folder, right-click the bookmark group to remove, and then click Delete 
Bookmarks Group.

2 In the Confirm Deletion window, read the message, and then click OK.
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Selecting Bookmarks to Display

For each Operations View Bookmarks portlet, you can select some or all of the 
available bookmark groups to display in the portlet, and you can add 
individual bookmarks to display in the portlet. You can determine the 
sequence in which bookmark groups and bookmarks appear in the portlet. 
This configuration determines the initial bookmarks portlet content.

If you allow bookmarks portlet edits, each user who is logged in to the portal 
server can choose which of the selected bookmark groups and bookmarks to 
display in that portlet. For information on how a user can customize the 
bookmarks portlet, see the online help file for that portlet.

Selecting the Bookmark Groups to Display in a Bookmarks Portlet

To set the initial list of bookmark groups to be displayed in an Operations 
View Bookmarks portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, navigate to your bookmarks 
portlet within the Portlet Applications folder.

2 In the Bookmarks Portlet Edit area of the editor pane, click Add 
Bookmarks Group.

3 In the Add Bookmarks Group window, select an entry from the list, and 
then click OK.

4 To change the relative position of a bookmark group, select the group, and 
then click Move Up or Move Down until the group is in the desired position.

5 After you have completed bookmark group selection, click Save.

Adding Bookmarks to Display in a Bookmarks Portlet

To add bookmarks to the initial list of bookmarks and bookmark groups to be 
displayed in an Operations View Bookmarks portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, navigate to your bookmarks 
portlet within the Portlet Applications folder.

2 In the Bookmarks Portlet Edit area of the editor pane, click Add 
Bookmark.
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3 In the Add New Bookmark window, enter the following information:

• Bookmark URL: The URL link to the bookmark. The URL must 
include the protocol designation http://. For example, use http://
managementsoftware.hp.com instead of 
managementsoftware.hp.com.

• Bookmark Name: The name of the link as it is displayed to users 
through their bookmarks portlets.

• Window Name (optional): The name of the new window to create (or 
reuse) when opening the URL so that the current portal view window 
is not replaced. The value should contain no spaces.

4 To change the relative position of a bookmark, select the bookmark, and 
then click Move Up or Move Down until the bookmark is in the desired 
position.

5 After you have completed bookmark selection, click Save.

Removing a Bookmark or Bookmark Group from a Bookmarks 
Portlet

To remove a bookmark or bookmark group from an Operations View 
Bookmarks portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, navigate to your bookmarks 
portlet within the Portlet Applications folder.

2 In the Bookmarks Portlet Edit area of the editor pane, select the 
bookmark or bookmark group to remove, and then click Remove.

3 In the Confirm Deletion window, click OK.

4 Click Save.

Users who have customized their bookmarks portlet do not see any changes 
that are made within the Administrator Tool to the bookmarks portlet 
configuration. They can delete a bookmark group on the bookmarks portlet 
edit page.
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8 Configuring the Operations View 
Message Board Portlet
The HP Operations Dashboard Operations View Message Board portlet can 
display important information, such as the status of problems in the managed 
environment or new services that you want to offer your customers, to your 
portal view users. This information is configured as one or more messages 
that can be displayed to one or more message board portlets.

This chapter describes the two aspects of using the message board portlet:

• Manage message content within the Operations View Message Board node 
in the Portlet Shared Configurations folder of the Administrator Tool. For 
information, see Managing Message Content on page 88.

• Select messages for display within the message board portlet(s) of your 
portlet application in the Portlet Applications folder of the Administrator 
Tool. For information, see Selecting Messages to Display on page 92.
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Managing Message Content

The Operations View Message Board portlet displays HTML-format content. 
Each message consists of one file. When creating a message with minimal 
HTML formatting, the editor within the Administrator Tool is sufficient. 
When creating a message with extensive HTML formatting, you can use an 
HTML editor to add the message content to the file you create with the 
Administrator Tool. Message files are stored in the following directory:

• Windows: <data_dir>\conf\dashboard\opview\share\
portlet-config\messageboard

• UNIX: /var/opt/OV/conf/dashboard/opview/share/
portlet-config/messageboard

While creating and modifying message content, observe the following best 
practices:

• Use only valid HTML tags allowed within a document body fragment.

• Ensure that the HTML formatting is correctly structured. That is, each 
opening tag (for example <p>) must have a matching closing tag (for 
example </p>).

In the Operations View Message Board folder of the Administrator Tool, you 
can do the following:

• Create new messages.

• Change the content of existing messages.

• Delete messages that no longer should be available for display in message 
board portlets.

Poorly formed HTML or HTML that contains inappropriate tags can cause 
portal display problems.
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Creating Messages

To create a new message for use in the Operations View Message Board 
portlet, follow these steps:

1 In the Operations View Administrator Tool, click File→ New→ Message for 
Message Board.

2 In the Add New Message window, type the file name and title of the new 
message.

• The message file name appears in the Operations View Message 
Board folder in the scoping pane and in the Message File Selection list 
in the editor pane for the message board portlets. The message file 
name must be unique, start with a letter, consist of only alphanumeric 
characters, and end with either the .html or the .htm extension.

This HTML message file name will contain the message content.

• The message title appears in the Operations View Message Board 
folder in the scoping pane. The message title should be unique and 
may contain any characters.

The new message name appears selected in the Operations View Message 
Board folder in the scoping pane, and the editor pane displays the new 
message with template content.

Message files that contain no content (the message file is empty) are not 
displayed in the message board portlet. This feature provides a way to 
prepare your message board portlets for urgent message delivery.

For example, if you assign to your portlet a message called “urgent” but leave 
the content blank, you can quickly disseminate information through this 
message in an emergency situation. After the emergency situation ends, 
remove the file contents but not the file itself. (If you delete a file that is 
assigned to a message board portlet, the portlet displays the message “Data 
currently unavailable.”)
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3 In the Message Content area at the top of the editor pane, enter the 
message content complete with HTML formatting tags.

At any point, click in the bottom text area to preview the message 
appearance.

4 After you have completed editing the message, click Save.

After you create a message, you cannot modify its HTML file name in the 
Administrator Tool. Instead, you must delete the file, and then create a 
different one with a new file name.

Changing the Content of a Message

If the message that you are changing is presented to multiple user roles, all of 
them will see the changes you make to the content.

To change the content of an existing message, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet Shared 
Configurations folder, expand the Operations View Message Board folder, 
and then select the message to change.

2 In the Message Content area at the top of the editor pane, edit the 
message content.

At any point, click in the bottom text area to preview the message 
appearance.

3 After you have completed editing the message, click Save.

Alternatively, edit the HTML message file in any text editor.

Alternatively, edit the HTML message file in any text editor.
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Deleting a Message

When you delete a message within the Administrator Tool, you remove its 
association with the Operations View Message Board folder, and you choose 
whether to also delete the file itself from the file system. You are not removing 
the message from the configuration of any portlets that use it, but those 
portlets can no longer display the deleted message.

Deleting a message from the Operations View Message Board folder has the 
following effects:

• If the message currently is not selected for display in a message board 
portlet configuration, the message file name is no longer available to be 
selected for display.

• If the message currently is selected for display in a message board portlet 
configuration, the message remains selected. Additionally, the message (or 
an error message if you also deleted the message file from the file system) 
is visible to users of the message board portlet until you remove the 
message file name from the Selected Message Files list or the user deletes 
the message in their portlet view.

To remove a message from use in the Operations View Message Board 
portlets, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Portlet Shared 
Configurations folder, expand the Operations View Message Board folder, 
right-click the message to remove, and then click Delete.

2 In the Confirm Deletion window, select the appropriate deletion option, 
and then click OK.

3 Examine each Operations View Message Board portlet configuration in 
the Administrator Tool. If the deleted message is in the Selected Message 
Files list, select that message file name, and then click Remove.

For more information, see Removing a Message from a Message Board 
Portlet on page 93.
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Selecting Messages to Display

For each Operations View Message Board portlet, you can select some or all of 
the available messages to display in the portlet. You can also determine the 
sequence in which messages appear in the portlet. This configuration 
determines the initial message board portlet content.

If you allow message board portlet edits, each user who is logged in to the 
portal server can choose which of the selected messages to display in that 
portlet. For information on how a user can customize the message board 
portlet, see the online help file for that portlet.

Selecting the Messages to Display in a Message Board Portlet

To set the initial list of messages to be displayed in an Operations View 
Message Board portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, navigate to your message 
board portlet within the Portlet Applications folder.

2 In the Message File Selection area of the editor pane, move the desired 
message file names into the Selected Message Files list. (And move any 
undesired message file names into the Available Message Files list.)

3 To change the relative position of a message, select the message file name, 
and then click Move Up or Move Down until the message is in the desired 
position.

4 After you have completed message selection, click Save.
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Removing a Message from a Message Board Portlet

To remove a message from an Operations View Message Board portlet, follow 
these steps:

1 In the scoping pane of the Administrator Tool, navigate to your message 
board portlet within the Portlet Applications folder.

2 In the Message File Selection area of the editor pane, select the message 
to remove, and then click Remove.

If the message still is associated with the Operations View Message Board 
folder, the message file name now appears in the Available Message Files 
list.

If the message has been deleted from the Operations View Message Board 
folder, the message file name is no longer visible.

3 Click Save.

Users who have customized their message board portlet do not see any 
changes that are made within the Administrator Tool to the message board 
portlet configuration. They can delete a message on the message board portlet 
edit page.
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9 Configuring the Opeartions View SQL 
Portlet
Operations View SQL Portlet (SQL portlet) displays data from the underlying 
configured database through a portal view.

Create a new portlet application and OVSQL portlet by using the Operations 
View Administrator Tool. 

1 Click Start->Programs->HP OpenView->Dashboard->Operations 
View->Administrator Tool.

2 Enter the following details to configure the SQL portlet in the 
PortletPreferences section.

• Query: Query to fetch and display the data from the database.

• Tuples: Number of rows that you want to display per page.

• DatabaseDriver: Driver information to connect to the database.

• Database Name: Database name used only when you configure a 
portlet for Microsoft SQL Server. Leave it blank if you configure a 
portlet for Oracle.

• Database User: Database User ID

• DatabasePassword: Database password

• DatabaseUrlString: JDBC URL. If you configure a portlet for Oracle, 
specify the database name as a part of DatabaseUrlString.

3 Click Save.

4 Deploy or redeploy the portlet application.

5 Add the portlet in a particular pane in JetSpeed.

6 View the portlet data. 
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Figure 7 SQL Portlet Output

You can change the query or the number of rows to be displayed in the portlet. 
To edit the query or tuple, click the Customize button on the right side of the 
portlet title bar.

Figure 8 Edit SQL Portlet
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10 Configuring the HP OpenView 
Integration Portlet
The HP OpenView Integration portlet provides a non-programmatic way to 
quickly incorporate your existing web applications, reports, and other data 
into the HP Operations Dashboard Operations View configuration. You can 
create your own full-featured portlets that can be managed in the 
Administrator Tool, extending the functionality of your Operations View 
configuration without writing portal-specific Java code.

The HP OpenView Integration portlet also provides limited proxying 
capabilities for the URLs. You can integrate into portal web sites that are 
behind a firewall and are not accessible to the end user.

This chapter describes the functionality and configuration of the 
HP OpenView Integration portlet. It contains the following sections:

• HP OpenView Integration Portlet Content on page 98 explains the types 
of content that can be integrated into an instance of the HP OpenView 
Integration portlet.

• Creating HP OpenView Integration Portlet Content on page 105 describes 
how to customize the HP OpenView Integration portlet configuration.

• Creating an HP OpenView Integration Portlet on page 111 describes how 
to use the Administrator Tool to create an instance of the HP OpenView 
Integration portlet.

Configuring the HP OpenView Integration portlet requires advanced skills 
and an XML editor tool. This task should be performed by an administrator 
who is comfortable with understanding DTD files and writing XML 
configuration files.
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HP OpenView Integration Portlet Content

The HP OpenView Integration portlet offers the following options for 
integrating content:

In addition, you can create a combination of these data types within one 
instance of the HP OpenView Integration portlet.

The following sections describe each of the content options in more detail.

Table 6 HP OpenView Integration Portlet Content Options

Content Option Description  Example Use Case

URLa Display content from 
a specified URL.

Given an HTML file on a different server, a CGI 
program, or another web application, display the 
contents of the URL by referencing the URL in 
the HP OpenView Integration portlet 
configuration file.

Command Display output from 
executable 
commands.

Run a command, such as ping or a command 
that generates results from a database, and 
display the output of the command in the portal.

File Display HTML from 
an external file.

Given a report in an HTML file on the local 
machine or a tool that generates reports in the 
form of HTML, display those reports through the 
portal by referencing the HTML file in the 
HP OpenView Integration portlet configuration 
file.

XML Translation Apply a transform to 
an XML file.

Given a file or a URL containing XML content 
and an XSL stylesheet that transforms the XML 
to HTML, display that HTML through the 
HP OpenView Integration portlet.

Embedded 
HTML

Display embedded 
HTML.

Given an HTML file containing static data, 
display the HTML content through the portal by 
embedding the HTML in the HP OpenView 
Integration portlet configuration file.

a. If you are using the Apache Jetspeed portal, consider using Apache's iframe portlet that is easier 
to use than the URL content option.
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The URL Content Option

The URL content option allows you to display the contents of a specified URL. 
For example, if you have an HTML file on a different server, or a CGI 
program, you can display the URL by referencing it in a portal view file. 

The URL display methods are described here. To use a specific method, 
include the correct setting of the displayMethod parameter as part of either 
the URL content option or the path to the file or URL to be accessed.

• Inline frames (IFRAMEs)

The HP OpenView Integration portlet displays the content in a scrollable 
window. The web browser bears the responsibility for displaying the URL. 
Web browsers that do not support IFRAMEs display a link.

displayMethod="inline"

• Anchor tags

The HP OpenView Integration portlet displays a link.

displayMethod="anchor"

• Embedded content

The HP OpenView Integration portlet takes control of the content of the 
URL for display purposes. It displays the content in a non-scrollable 
window.

displayMethod="embedded"

Figure 9 shows a sample configuration file that displays the content of a file.

Figure 9 Example URL Content

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
<Submodule>
<TitleBar title="HP E-Services IFRAME on IE,
Link on Netscape"/>

<Url anchorText="HP E-Services" displayMethod="inline"
href="http://www.hp.com/e-services" inlineHeight="300"
proxy="no"/>

</Submodule>
</Generic>
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To activate the use of inline frames through the IFRAME HTML tag, set the 
displayMethod attribute to inline and use the inlineHeight attribute to 
specify the height of the inline frame. The default height is 100 pixels.

Proxying Capabilities

The Operations View proxy capabilities allow you to provide the following 
functionality:

• Restricted access to a web page, web data, web server, and so forth.

• Access through Operations View to management product data without 
requiring the user to log in to the product.

The HP OpenView Integration portlet provides limited proxying capabilities 
when displaying the content of a URL. When the proxy attribute is set to yes, 
the portal server, not the web browser, accesses the URL directly (for example, 
over the secure network). In this way, you can display portal data that 
otherwise would not be accessible to the end user. In addition, you can also 
provide the name and password that will be used when accessing the 
protected data.

Not all URLs proxy well through the HP OpenView Integration portlet. If the 
URL uses JavaScript extensively, the page may not display fully correctly or 
some of its functionality will not be available in the module. In this case, you 
may need to set the proxy attribute to no and make the data system accessible 
to end users.

Authentication Capabilities

Some URLs require authentication before displaying content. You can 
configure Operations View to automatically perform the required 
authentication prior to accessing the target URL. In this case, the portal uses 
the same authentication credentials for all users of this portlet.

Netscape versions prior to 6.0 do not support inline frames; the URL will be 
displayed as an anchor tag using anchorText as the text for the anchor. If you 
set displayMethod to anchor, an anchor tag will always be present on both 
Internet Explorer and Netscape.

Read the Proxy Configuration whitepaper to understand how you can 
configure the proxy to work for your application. This whitepaper is available 
from the HP OpenView website.
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Operations View supports two forms of authentication for HP OpenView 
Integration portlet URL access:

• Web server authentication

• Login page authentication

The Command Content Option

The command content option allows you to execute a command on the portal 
server and capture the results into a portlet. By default, a command is run as 
the portal server user.

Figure 10 shows a sample configuration file that performs two commands: 
ping and nslookup on a host.

Figure 10 Example Command Content

For most commands that do not output HTML, set the type attribute to text/
plain and set the stripHTMLHeader attribute to no. If the command outputs 
HTML-formatted content, then set the type attribute to text/html and set 
the stripHTMLHeader attribute to yes.

To prevent unauthorized users from running commands, configure the 
following security measures appropriately:

• On the command server, restrict the users who are allowed to run the 
commands.

• Using the portal server software tools, restrict user access to portlets that 
run commands.

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
Submodule>
<TitleBar title="Ping"/>
<Command commandLine="ping host.hp.com" stripHtmlHeader="no"
type="text/plain"/>

</Submodule>
<Submodule>
<TitleBar title="Nslookup"/>
<Command commandLine="nslookup host.hp.com"
stripHtmlHeader="no" type="text/plain"/>

</Submodule>
</Generic>
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The File Content Option

The file content option allows you display content from the file system, similar 
to the Operations View Message Board portlet. This content option is useful 
for content that changes dynamically. Figure 11 shows a sample configuration 
file that displays the content of a file.

Figure 11 Example File Content

Ensure that you specify the correct value for type as explained for the 
command content option.

The following considerations apply when displaying external HTML through 
the HP OpenView Integration portlet.

• The file must be on your local machine or network. It cannot require http 
access. If you want to display files on a remote web server, see The URL 
Content Option on page 99.

• The file can be HTML or plain text. When the content is HTML, set the 
type to text/html. When the content is plain text, set the type to
text/plain.

• The HTML should be well formed.

• The contents of an external HTML file should not include header tags 
such as <HTML></HTML>, <HEAD></HEAD>, or <BODY></BODY>. The portal 
automatically provides these tags. If your HTML files include these tags, 
you can use stripHTMLHeader. For more information about 
stripHTMLHeader, see Table 13 on page 183.

• If you have style sheets in a file, your imported style sheets might be 
ignored. If you embed content from a URL that defines a cascading style 
sheet, it overrides the Operations View cascading style sheet.

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
<Submodule>
<File fileName="C:\Temp\readme.txt" displayFileInfo="yes"   
encoding="UTF-8" type="text/plain"/>

</Submodule>
</Generic>
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The XML Translation Content Option

The XML translation content option allows you to apply a transform to an 
XML file. For example, if a file or a URL has XML content, and if you have an 
XSL stylesheet that transforms the XML to HTML, then you can display that 
HTML through the HP OpenView Integration portlet.

Figure 12 shows a sample configuration file that displays the output of a file 
transformation.

Figure 12 Example XmlTranslation Content

The Embedded HTML Content Option

The HTML content option allows you to display HTML within a portlet and is 
most useful for static content that seldom changes. Figure 13 shows a sample 
configuration file that displays HTML content.

Figure 13 Example HTML Content

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
<Submodule>
<XmlTranslation xmlHref="C:\Program Files\HP OpenView\
data\conf\dashboard\opview\share\portlet-config\generic\
svchealth.xml" xslHref="C:\Program Files\HP OpenView\
data\conf\dashboard\opview\share\portlet-config\generic\
styles\svchealth.xsl" type="text/html"/>

</Submodule>
</Generic>

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
<Submodule>
<TitleBar title="foo" status="red" titleAnchorText="anchor"
titleAnchorUrl="www.hp.com"/>

<EmbeddedHtml data="&lt;table width=&quot;100%&quot;&gt;
&lt;tr&gt;&lt;td&gt;column one data&lt;/td&gt;
&lt;td&gt;column two data&lt;/td&gt;&lt;/tr&gt;&lt;
/table&gt;"/>

</Submodule>
</Generic>
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You will notice that the html is encoded because it is embedded within an 
XML file. For example, the HTML tag <p align="center"> appears as &lt;p 
align=&quot;center&quot; &gt; to correct the quotation mark and tag 
symbols.
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Creating HP OpenView Integration Portlet Content

Each HP OpenView Integration portlet instance is configured by an XML file 
that defines the content for that portlet instance. The XML syntax is specified 
in the OVGeneric.dtd file.

The HP OpenView Integration portlet configuration files and the 
OVGeneric.dtd file are located in the following directory:

• Windows: <data_dir>\conf\dashboard\opview\share\
portlet-config\generic

• UNIX: /var/opt/OV/conf/dashboard/opview/share/
portlet-config/generic

You can organize your XML configuration files within subdirectories of the 
generic directory. In this case, verify that the document type definition (DTD) 
declaration in each XML file points to the correct location of the 
OVGeneric.dtd file.

The syntax for HP OpenView Integration portlet configuration consists of one 
or more submodules. Each submodule consists of an optional title statement 
followed by a content statement. Within a portlet configuration, you can mix 
and match content types as needed.

The recommended steps to create content for an HP OpenView Integration 
Portlet are as follows:

1 Using an XML editor tool, open the SampleConfig.xml file in the 
HP OpenView Integration portlet configuration directory and then save 
the configuration file with a new name, such as myOVIntegration.xml.

2 Modify the file content. Figure 14 shows the general syntax of an 
HP OpenView Integration portlet XML configuration file.

To change the XML configuration for an out-of-the box implementation of the 
HP OpenView Integration portlet, HP recommends that you update a copy of 
the existing XML configuration file and then modify the portlet configuration 
in the Administrator Tool to use this new file.
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Figure 14 HP OpenView Integration Portlet General Syntax

The possible values for the <Content/> statement are described in HP 
OpenView Integration Portlet Content on page 98.

Using Variables to Access Operations View Data

Your HP OpenView Integration portlet can use predefined variables to 
retrieve user-specific information from Operations View. Table 7 lists and 
describes the variables that are available to the HP OpenView Integration 
portlet.

Table 7 also lists the attributes that can correctly interpret these variables. 
These attributes are listed in the format XMLElement@attributeName. 

For example, Command@commandLine means that the commandLine attribute of 
the Command element can include the given variable.

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
<Submodule>
<TitleBar title="Title 1"/>
<Content/>

</Submodule>
<Submodule>
<TitleBar title="Title 2"/>
<Content/>

</Submodule>
</Generic>

The HP OpenView Integration portlet configuration file must conform to the 
syntax defined in the OVGeneric.dtd file. For information, see Appendix C, 
HP OpenView Integration Portlet DTD.
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Table 7 Substitution Variables

Variable Description Supported Uses

$CONF_DIR Returns the top-level 
directory for the 
Operations View 
configuration data as 
defined in the 
Path.properties files.
For example: 
C:\Program Files\
HP OpenView\data\
conf\dashboard\opview\

• Command@commandLine
• File@fileName
• XmlTranslation@xmlHref
• XmlTranslation@xslHref

Example:
fileName="$CONF_DIRshare\
portlet-config\messageboard\Demo\
Welcome.html"

$OVLOGIN Returns the current 
user’s login name.

• Command@commandLine
• File@fileName
• Url@href
• Url@auth
• Url@loginUrl
• Url@handshakeUrl
• XmlTranslation@xmlHref
• XmlTranslation@xslHref

Example:
auth="$OVLOGIN:acmepasswd"
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$INIT_PARAM
[portlet_init_
parameter]

Returns the 
configuration setting for 
the specified portlet 
initialization parameter 
in the portlet.xml file.

• Command@commandLine
• File@fileName
• Url@href
• Url@auth
• Url@loginUrl
• Url@handshakeUrl
• XmlTranslation@xmlHref
• XmlTranslation@xslHref

Example:
auth="$INIT_PARAM[OVPI.userName]:
$INIT_PARAM[OVPI.password]"

$PREFERENCE
[portlet_
preference_name]

Returns the 
configuration setting in 
the portlet.xml file for 
the specified portlet 
preference. If the portlet 
preference includes 
multiple values, the 
variable returns the first 
value only.

• Url@href
• Url@auth
• Url@loginUrl 
• Url@handshakeUrl
• XmlTranslation@xmlHref
• XmlTranslation@xslHref

Example:
auth="vLogin=userName&amp;
vPasswd=password&amp;
vTimezone=$PREFERENCE[Timezone]"

Table 7 Substitution Variables (cont’d)

Variable Description Supported Uses
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Making Portlet Preferences User Editable

The HP OpenView Integration portlet can support user configuration of the 
portlet preferences. This user configuration functions the same as for the 
Operations View portlets.

Enabling user configuration of an HP OpenView Integration portlet 
preference involves several elements in the portlet configuration file:

• Use the GlobalParms element to define the portlet preference. See 
GlobalParms Element Attributes on page 192.

• Use the $PREFERENCE variable to pass the portlet preference as a 
parameter. Table 7 on page 107 lists the syntax and supported uses of this 
variable.

• Use the OptionParm element within the HP OpenView Integration portlet 
content option to create user editable field for configuring the portlet 
preference.

For example, Figure 15 on page 110 shows a configuration file that uses the 
URL content option to display a report. The Url element references the Report 
portlet preference. The OptionParm element provides for user configuration of 
the Report portlet preference. The default value is Device Top Ten. The Option 
elements provide five possible values for the Report portlet preference.

Figure 16 on page 110 shows the resulting portlet edit page.

The file shown in Figure 15 is a slightly modified subset of the 
PerfInsight.xml configuration file available in the following directory:

• Windows: <data_dir>\conf\dashboard\opview\share\
portlet-config\generic

• UNIX: /var/opt/OV/conf/dashboard/opview/share/
portlet-config/generic
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Figure 15 Example Editable Portlet Preference Configuration

<?xml version="1.0" standalone="no"?>
<!DOCTYPE Generic SYSTEM "OVGeneric.dtd">
<Generic>
<Submodule>
<Url anchorText="Performance Insight Report"
auth="$INIT_PARAM[OVPI.userName]:$INIT_PARAM[OVPI.password]"
displayMethod="inline" handshake="yes" 
handshakeUrl="http://$INIT_PARAM[OVPI.server]/reports/home"
href="http://$INIT_PARAM[OVPI.server]/reports/webview?
rn=/$PREFERENCE[Report]&amp;ov_user=$INIT_PARAM[OVPI.userName]"
inlineHeight="400" proxy="yes">
<OptionParm name="Report" prompt="Choose report:"
value="Device Top Ten">
<Option name="Device Exceptions Summary"
value="system/DeviceResource/Device/Device_Exception.rep"/>

<Option name="Device Forecast"
value="system/DeviceResource/Device/Device_Forecast.rep"/>

<Option name="Device Top Ten" 
value="system/DeviceResource/Device/Device_TopTen.rep"/>

<Option name="Interface Top Ten" 
value="system/Interface_Reporting/Interface/Top_Ten.rep"/>

<Option name="Interface Unreachable"
value="system/Interface_Reporting/Interface/Unreachable.rep"/>

</OptionParm>
</Url>

</Submodule>
</Generic>

Figure 16 Example Portlet Edit Page
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Creating an HP OpenView Integration Portlet

To create a new instance of the HP OpenView Integration portlet, follow these 
steps:

1 In the Administrator Tool, click File→ New→ Portlet.

2 In the Add New Portlet window, enter the following information:

• Portlet Name: The name of the portlet as it appears in the portlet 
application.

• Portlet Title: The name of the portlet as it appears in the portal view. 
Defaults to the portlet name.

• Description (optional): The portlet description.

• Portlet Type: Select OV_Integration.

• Destination Portlet Application: Select the portlet application to 
contain the new portlet.

The new portlet appears in the selected portlet application in the scoping 
pane, and the configuration information for this portlet appears in the 
editor pane.

3 In the HP OpenView Integration Portlet Edit area, select the correct 
portlet configuration file from the Configuration File list.

4 Click Save.
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11 Deploying a Portlet Application
This chapter describes the process for moving an HP Operations Dashboard 
Operations View portlet application into the deployed phase. The process to 
complete this task is different for each supported portal server. The 
information in this chapter applies to step 6 in the portal view 
implementation process shown in Figure 5 on page 42.

This chapter contains the following sections:

• Deploying a Portlet Application to Apache Jetspeed on page 114

• Deploying a Portlet Application to BEA WebLogic on page 115
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Deploying a Portlet Application to Apache Jetspeed

The Operations View Administrator Tool facilitates the process of deploying 
an Operations View portlet application to Apache Jetspeed.

To deploy an Operations View portlet application to a Jetspeed portal server, 
follow these steps:

1 Ensure that Jetspeed is running.

2 In the Administrator Tool, expand the Portlet Applications folder, 
right-click the portlet application name, and then click Deploy Jetspeed 
Portlet Application.

The information in the editor pane changes as follows:

• The Deployment Phase now shows deployed.

• The Deployment Directory field now lists the directory that Jetspeed 
reads for portlet content.

• The Portlet Configuration File is now located within the Jetspeed 
directory structure.

The portlets that you have configured for this portlet application are now 
available to be included in a Jetspeed portal view. The portlet 
configuration changes that you make in the Administrator Tool appear in 
subsequent refreshes of the portal view.

If you allow users to edit their portlet preferences, configuration changes that 
you make in the Administrator Tool have no effect on the configuration of 
portlets that have been customized by a user. For more information, see 
Portlet Preference on page 33.
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Deploying a Portlet Application to BEA WebLogic

The process for deploying an Operations View portlet application to BEA 
WebLogic involves the following steps:

1 Import the portlet application into a BEA WebLogic portal application.

2 Update the Operations View Administrator Tool with the new location of 
the portlet application files.

To deploy an Operations View portlet application to a BEA WebLogic portal 
server, follow these steps:

Task 1: Create a Portal Application on the Portal Server

1 Start BEA WebLogic Workshop:

• Windows: Click Start→ Programs→ BEA WebLogic Platform 8.1→ 
WebLogic Workshop 8.1.

• UNIX: In a terminal window, type:
<bea_install_dir>/weblogic81/workshop/Workshop.sh

2 In BEA WebLogic Workshop, click File→ New→ Application.

3 In the New Application window, do the following:

a Select Portal Application in the right-hand pane.

b For the Directory field, click Browse, and then navigate to the 
directory for your new application.

c The value in the Name field is the name that will appear in the BEA 
WebLogic configuration tools. Verify the portal application name.

d If the Server field does not point to the correct portal domain server, 
click Browse, and then navigate to the config.xml file for the server 
(portal domain) that you want to use.

BEA WebLogic refers to the portlet applications as projects within a portal 
application.

Ensure that the Login portlet is added on the portal page. You need to login to 
view the portlets.
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If an appropriate portal domain server does not exist, use the BEA 
WebLogic Configuration Wizard to create a new portal domain server. 
For information on this process, see the BEA document Getting 
Started with Portal Development available from 
http://edocs.bea.com.

e Click Create to create the application.

The new portal application appears in the Application pane of BEA 
WebLogic. The application includes the following content:

— The WebLogic Administration Portal (adminPortal.war in the 
Modules folder).

— The data folder for interaction management development.

— Application-level EJBs and APIs.

Task 2: Creating a BEA Portal Web Project on the Portal Server

1 In BEA WebLogic Workshop, right-click the portal application you created 
in Task 1 on page 115, and then click Import Project.

2 In the Import Project - New Project window, select Portal in the left-hand 
pane, and then select Portal Web Project in the right-hand pane.

3 Click Browse, and then navigate to the staging directory for your 
Operations View portlet application. (This information is available in the 
editor pane of the Administrator Tool when the portlet application is 
selected in the scoping pane.)

4 Select the Copy into Application directory check box.

5 The value in the Name field is the name that will appear in the BEA 
WebLogic configuration tools. Verify the project name, and then click 
Import.

6 When a message window asks if you want Workshop to update your 
project, click Yes.

The project appears as a folder within the portal application.

7 To see the Operations View portlets, expand the project folder, and then 
expand the opview_portlets folder.
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Task 3: Update the Operations View Configuration on the Operations View Server

1 In the navigation pane of the Administrator Tool, expand the Portlet 
Applications folder, right-click the portlet application, and then click 
Switch to Deployment.

2 In the Switch to Deployment window, click Browse, and then navigate to 
the location of the portal project within the BEA WebLogic file structure.

3 Select the I have imported this portlet application into BEA as a portal 
project check box, and then click OK.

The information in the editor pane changes as follows:

• The Deployment Phase now shows deployed.

• The Deployment Directory field now lists the directory that BEA 
WebLogic reads for portlet content.

• The Portlet Configuration File is now located within the BEA 
WebLogic directory structure.

The portlets that you have configured for this portlet application are now 
available to be included in a BEA WebLogic portal view. The portlet 
configuration changes that you make in the Administrator Tool appear in 
subsequent refreshes of the portal view.

If you allow users to edit their portlet preferences, configuration changes that 
you make in the Administrator Tool have no effect on the configuration of 
portlets that have been customized by a user. For more information, see 
Portlet Preference on page 33.
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Next Steps

After the Operations View portlet application is deployed, use the portal 
server software tools to lay out your portal views. For information on 
completing this task, see the portal server documentation.

You will continue to use the Administrator Tool to manage the content of the 
Operations View portlets. Because the Administrator Tool has been updated 
with the location of the deployed portlet application, portlet configuration 
changes that are made in the Administrator Tool are automatically available 
to the portal views. To see a portlet configuration change, refresh the view in 
the web browser. For more information, see Maintaining Portlet 
Configurations on page 78.
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12 Configuring Operations View Data 
Filters
A data filter limits the data that is displayed through a portlet according to 
the access configured for the portal view user. The HP Operations Dashboard 
Operations View supports a variety of data filtering implementations 
depending on the Operations View portlets:

• The Operations View portlets for the following HP OpenView 
management products use the Operations View customer model and filter 
assignments. For information on configuring data filtering for these 
portlets, see the rest of this chapter:

— HP OpenView Network Node Manager (NNM)

— HP OpenView Operations (OVO)

— HP OpenView Service Navigator (OVSN)

— HP OpenView Operations for Windows (OVO/W)

— HP OpenView Performance Manager (OVPM)

• The Operations View portlets for the following HP OpenView 
management products use their own filtering mechanism. Operations 
View takes advantage of these external mechanisms through portlet 
preferences and initialization parameters. You do not need to create 
customer models or filter assignments in order to display filtered data 
from these products. For information on configuring these filtering 
mechanism, see the appropriate integration guides:

— HP OpenView Internet Services (OVIS) 

— HP OpenView Service Desk (OVSD)

The default configuration for Operations View portlets is to allow 
authenticated users to see all portlet data. If you do not want to 
implement content filtering at this time and the default 
configuration does not fit your needs, see Managing Filter 
Assignments on page 127.
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— HP OpenView Performance Insight (OVPI)

— HP OpenView Reporter (OVR)

• The following Operations View portlets do no data filtering:

— Message board portlet

— Bookmarks portlet

This chapter describes the levels of Operations View content filtering. The 
information in this chapter applies to step 4 in the portal view 
implementation process shown in Figure 5 on page 42.

This chapter includes the following sections:

• Managing Customer Models with the Administrator Tool on page 121 
explains how to use the Operations View Operations View to create and 
maintain a customer model source and organizations.

• Managing Filter Assignments on page 127 explains how to create and 
maintain filter assignment packages and filter assignments.

• Selecting Filter Assignments to Apply on page 132 explains how to 
configure the filter assignments for a portlet that uses the Operations 
View customer model.

• Advanced Topic: Defining a Customer Model Outside of the Administrator 
Tool on page 134 discusses the requirements for a customer model source 
that is created separately from the Administrator Tool.

• Advanced Topic: Importing a Customer Model Source into the Operations 
View Configuration on page 136 explains how to import an externally 
developed customer model source into the configuration that the 
Administrator Tool maintains.
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Managing Customer Models with the Administrator 
Tool

In order to display a filtered view of NNM, OVO, OVSN, or OVPM 
management data in Operations View, at least one customer model source 
must contain associations between organizations and the resources of the 
management product. Operations View pulls from these management 
products the data for the resources that are named in one of your customer 
model sources.

If a resource is managed by NNM, OVO, OVSN, or OVPM but is not included 
in an organization definition, the data for that resource is not displayed to 
users accessing the filter assignment. The exception to the preceding 
statement occurs when users can utilize the AllData filter, which allows all 
data to be displayed as described in Managing Filter Assignments on 
page 127.

A customer model source, typically a file, can contain one or more 
organizations. You can group your organizations in one or multiple customer 
model sources as desired. Use the Administrator Tool to configure customer 
models. You can also import pre-existing customer model sources into the 
Operations View configuration.

The process for creating a customer model is very flexible and consists of two 
main tasks:

• Create and map organizations to their resources. This task means naming 
organizations and determining what resources each organization can 
access. Typically, this decision correlates to the smallest amount of data 
that you want to be able to display to a group of portal users.

For example, given the following groups of portal users:

– Members of GroupA need to see a small number of filtered 
resources.

– Members of GroupB need to see a large number of filtered 
resources, including those accessed by GroupA.

If you do not want to use any data filtering, you do not need to implement an 
Operations View customer model. In this case, go to Managing Filter 
Assignments on page 127.
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— Create the following organizations:

– OrganizationX includes only the set of resources needed by 
members of GroupA.

– OrganizationY and OrganizationZ include the additional 
resources needed by members of GroupB.

— Then, create the following filter assignments:

– FilterAssignment1 includes only OrganizationX for GroupA.

– FilterAssignment2 includes OrganizationX, OrganizationY, and 
OrganizationZ for GroupB.

There are two ways to create a customer model source.

— Create a customer model source and map organizations to resources 
as described in this section.

— Create a program to provide a mapping from an arbitrary data store 
or provisioning system to the required customer model format. Use 
this approach if you want to write a program that converts data from 
an existing data source into the required XML format for the 
Operations View customer model. For information on developing and 
using your own customer model data file, see Advanced Topic: 
Defining a Customer Model Outside of the Administrator Tool on 
page 134 and Advanced Topic: Importing a Customer Model Source 
into the Operations View Configuration on page 136.

• Create lists of resources (optional). This task creates a list of filtered 
resources that can be referenced by multiple organizations.

For example, given several services that are used by multiple 
organizations for content filtering, you can define the list of services once, 
and multiple organizations can reference this service list. In this way, you 
do not have to configure the services individually for each organization.

Each portlet that uses filtering does so in a unique way. For information on 
the filtering attributes that each portlet uses and on creating lists of nodes, 
interfaces, topology map objects (non-NNM-discovered nodes), and services 
that can be associated with organizations, refer to the following manuals:

• Operations View Integration Guide: NNM

• Operations View Integration Guide: OVO and OVSN

• Operations View Integration Guide: OVPM
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Creating a Customer Model Source

To create a customer model source, follow these steps:

1 In the Administrator Tool, click File→ New→ Customer Model Data File.

2 In the Add New Customer Model Data File window, enter the customer 
model source name, and then click Save.

The new customer model source appears selected in the Customer Model 
Sources folder in the scoping pane, and the editor pane displays the 
customer model information page.

Creating an Organization

The following procedure assumes that you have already created your resource 
lists, as described in the integration manual for the HP OpenView 
management product. Repeat this procedure for each organization you want to 
create.

To create an organization, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Customer Model Sources folder, and then select the 
customer model source to modify.

The editor pane displays the customer model information page.

2 In the editor pane, click New Organization.

3 In the Add New Organization window, enter the organization name, select 
the customer model source to which this organization belongs, and then 
click OK.

The new organization appears selected in the Customer Model Sources 
folder in the scoping pane, and the editor pane displays the configuration 
for that organization.

4 Optionally, enter a display string for use within the Administrator Tool. If 
the display string is not set, the organization name appears in the filter 
assignments configuration.
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5 Follow the appropriate product integration manuals to configure the 
resources for your organization.

• For information on configuring services, see Operations View 
Integration Guide: OVO and OVSN.

• For information on configuring nodes, see Operations View Integration 
Guide: NNM, Operations View Integration Guide: OVO and OVSN, or 
Operations View Integration Guide: OVPM as appropriate.

• For information on configuring interfaces, see Operations View 
Integration Guide: NNM.

• For information on configuring NNM topology objects, see Operations 
View Integration Guide: NNM.

• For information on configuring virtual private networks (VPNs), see 
Operations View Integration Guide: NNM.

6 After you have completed configuring the organization, click Save.

Modifying an Organization

To change the contents of an organization, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Customer Model Sources folder, expand the appropriate 
customer model source, and then select the organization to modify.

2 Update the configuration as needed. For information, see the product 
integration manual for the HP OpenView product that implements the 
filtering you want.

3 After you have completed modifying the organization, click Save.
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Deleting an Organization

When you delete an organization, you remove its data from the customer 
model source. You are not removing that organization from any filter 
assignments that use the organization.

Deleting an organization from the Customer Model Sources folder has the 
following effects:

• If the organization currently is not selected by any filter assignments, the 
organization is no longer available to be selected for use.

• If the organization currently is selected by one or more filter assignments, 
the organization remains listed in the filter assignment configuration but 
is ignored when the portlet interprets the filter assignment.

To remove an organization from use in the filter assignments, follow these 
steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Customer Model Sources folder, expand the appropriate 
customer model source, right-click the organization to remove, and then 
click Delete Organization.

2 In the Confirm Deletion window, read the message, and then click OK.

3 Examine each filter assignment configuration in the Administrator Tool. 
If the deleted organization is in the Show Data for the Following 
Organizations list, select that organization, and then click Remove.

For more information, see Modifying a Filter Assignment on page 129.
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Deleting a Customer Model Source

When you delete a customer model source, you remove its association with the 
Customer Model Sources folder, and you choose whether to also delete the file 
itself from the file system. You are not removing the organizations contained 
in the customer model source from any filter assignment configurations.

Deleting a customer model source from the Customer Model Sources folder 
has the following effects:

• If the organizations in the file currently are not selected for use in any 
filter assignment, the organization is no longer available to be selected for 
use.

• If any of the organizations in the file currently is selected for use in a filter 
assignment configuration, the organization remains listed in the 
configuration but is ignored when the portlet interprets the filter 
assignment.

To remove a customer model source from the Operations View configuration, 
follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Customer Model Sources folder, right-click the customer 
model source to remove, and then click Delete Customer Model.

2 In the Confirm Deletion window, select the appropriate deletion option, 
and then click OK.

3 Examine each filter assignment configuration in the Administrator Tool. 
If any of the organizations contained in the deleted customer model source 
is in the Show Data for the Following Organizations list, select that 
organization, and then click Remove.

For more information, see Modifying a Filter Assignment on page 129.
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Managing Filter Assignments

Operations View includes two special filter assignments, the AllData and 
NoData filter assignments. These filter assignments are very important 
because they can implement a global default data security policy. HP 
recommends that you use one or both of these filter assignments.

The following examples describe the two extremes of data filtering. You might 
find that some aspects of each technique apply to your situation. The primary 
consideration is to always have at least one filter assignment that uses the all 
users security constraint. This filter assignment becomes the default filter 
assignment for many users if the appropriate filter assignment is not yet 
defined.

• If you want to tightly restrict and control data access, HP recommends 
that you ensure the NoData filter assignment is set to allow all users 
access (the default setting) and limit the AllData filter assignment to a list 
of portal roles (not the default setting). This approach enables any user 
accessing a portlet to at least have the NoData filter assignment available 
to them (preventing unfriendly error messages) and restricts the AllData 
filter assignment to only those users in the appropriate portal roles. 
Typically, you would also create several organizations and filter 
assignments that represent each of the unique filtered views that you 
want to present to portal users.

• If you do not have strict data access concerns, you can set the AllData 
filter assignment to allow all users and, if appropriate, delete any other 
filter assignments. This approach, in effect, disables all data filtering.

Filter assignments can be organized into packages. A filter assignment 
package file is an XML file that contains one or more filter assignment 
definitions. You can use filter assignment package files as a way to organize 
larger deployments or complex filtering situations. Use the Administrator 
Tool to configure the filter assignments.

You can change the names of the AllData and NoData filter assignments.
Configuring Operations View Data Filters 127



HP Operations Dashboard Operations View Administrator Guide Version 2.10
Creating a Filter Assignment Package (Optional)

Operations View includes two filter assignment packages: Default Filter 
Assigments and Sample Filter Assignments. You can create new filter 
assignment packages, or you can add your own filter assignments to the 
existing filter assignment packages.

To create a filter assignment, follow these steps:

1 In the Administrator Tool, click File→ New→ Filter Assignment Package.

2 In the Add New Filter Assignment Package window, enter the package 
name, and then click Save.

The new filter assignment package appears selected in the Filter 
Assignments folder in the scoping pane, and the editor pane displays the 
filter assignments information page.

Creating a Filter Assignment

To create a filter assignment, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Filter Assignments folder, and then select the filter 
assignment package to modify.

The editor pane displays the filter assignment information page.

2 In the editor pane, click New Filter Assignment.

3 In the Add New Filter Assignment window, enter the filter assignment 
name, select the filter assignment package to which this filter assignment 
belongs, and then click OK.

The new filter assignment appears selected in the Filter Assignments 
folder in the scoping pane, and the editor pane displays the configuration 
for that filter assignment.
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4 In the Security Constraints area of the editor pane, select which users can 
access the information identified in the Data Presentation area.

• Allow All Authenticated Users: All users who have logged in to the 
portal server can see data.

• Allow All Users (Including Anonymous Access): All users, including 
those who have not logged in to the portal server, can see data.

• Allow Users from the Following Portal Roles: Users of the selected 
roles can see data.

5 In the Data Presentation area of the editor pane, select the data that is 
available to the users identified in the Security Constraints area.

• Show All Data: Identified users will see all data presented by the 
portlet. Use this option if you are not concerned about differentiating 
what data your users see or if you have not yet set up a customer 
model. 

• Show No Data: Identified users will not see any live data through the 
portlet. Use this option to prevent any data from passing a filter.

• Show Data for the Following Organizations: Identified users will see 
data for the resources in the organizations. If you select this option, 
follow these steps to complete the configuration:

— Click Add.

— In the Select Organization window, select one or more 
organizations, and then click OK.

6 After you have finished configuring the filter assignment, click Save.

Modifying a Filter Assignment

To change the contents of a filter assignment, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Filter Assignments folder, expand the appropriate filter 
assignment package, and then select the filter assignment to modify.

2 To change the user configuration, in the Security Constraints area of the 
editor pane, select which users can access the information identified in the 
Data Presentation area. For information, see Step 4 on page 129.
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3 To change the resource configuration, in the Data Presentation area of the 
editor pane, select the data that is available to the users identified in the 
Security Constraints area. For information, see Step 5 on page 129.

4 After you have finished modifying the filter assignment, click Save.

Deleting a Filter Assignment

When you delete a filter assignment, you remove its association with the 
Filter Assignments folder. You are not removing that filter assignment from 
the configuration of any portlets that use it, but those portlets can no longer 
use the deleted filter assignment.

Deleting a filter assignment from the Filter Assignments folder has the 
following effects:

• If the filter assignment currently is not selected for use in any Operations 
View portlet configuration, the filter assignment is no longer available to 
be selected for use.

• If the filter assignment currently is selected for use in an Operations View 
portlet configuration, the filter assignment remains listed in the 
configuration but is ignored when the portlet determines which filter 
assignment to use for the current user and portal view.

To remove a filter assignment from use by the Operations View portlets, follow 
these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Filter Assignments folder, expand the appropriate filter 
assignment package, right-click the filter assignment to remove, and then 
click Delete Filter Assignment.

2 In the Confirm Deletion window, read the message, and then click OK.

3 Examine each Operations View portlet configuration in the Administrator 
Tool. If the deleted filter assignment is in the Priority of Filter 
Assignments list, select that filter assignment, and then click Remove.

For more information, see Removing Filter Assignments from a Portlet on 
page 133.
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Deleting a Filter Assignment Package

When you delete a filter assignment package, you remove its association with 
the Filter Assignments folder, and you choose whether to also delete the file 
itself from the file system. You are not removing the contained filter 
assignments from the configuration of any portlets that use them, but those 
portlets can no longer use the deleted filter assignments.

Deleting a filter assignment package from the Filter Assignments folder has 
the following effects:

• If the filter assignments in the package currently are not selected for use 
in any Operations View portlet configuration, the filter assignment is no 
longer available to be selected for use.

• If any of the filter assignments in the package currently is selected for use 
in an Operations View portlet configuration, the filter assignment 
remains listed in the configuration but is ignored when the portlet 
determines which filter assignment to use for the current user and portal 
view.

To remove a filter assignment package from the Operations View 
configuration, follow these steps:

1 In the scoping pane of the Administrator Tool, expand the Data Filters 
folder, expand the Filter Assignments folder, right-click the filter 
assignment package to remove, and then click Delete Filter Assignment 
Packages.

2 In the Confirm Deletion window, select the appropriate deletion option, 
and then click OK.

3 Examine each Operations View portlet configuration in the Administrator 
Tool. If any of filter assignments contained in the deleted filter 
assignment package is in the Priority of Filter Assignments list, select 
that filter assignment, and then click Remove.

For more information, see Removing Filter Assignments from a Portlet on 
page 133.
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Selecting Filter Assignments to Apply

Each portlet that uses management data filter assignments can include any 
number of filter assignments in its configuration. If no filter assignment is 
specified, the portlet uses the first available filter assignment. (In this case, 
there is no way to predict or control which filter assignment is used.) If 
multiple filter assignments are specified, Operations View determines which 
filter assignment controls data presentation on an individual user basis. Thus, 
ordering of the filter assignments is important.

For example, a portlet might allow the user admin to see the data represented 
by the AllData filter assignment. It might also limit the user acmeuser to 
seeing the data represented by a filter assignment containing the organization 
acme. The principles behind this differentiation are as follows:

• The Priority of Filter Assignments portlet preference can contain an 
ordered list of filter assignments. Operations View uses the first filter 
assignment in this list to which the user has access (from the security 
constraints).

• If the Priority of Filter Assignments portlet preference is not specified, or 
the current user does not have access to any of the filter assignments 
specified by this portlet preference, then Operations View examines all of 
the filter assignments in the Data Filters folder of the Administrator Tool. 
Operations View uses the first filter assignment to which the user has 
access. This analysis of all available filter assignments occurs in an 
unspecified order. If you expect that users will have access to more than 
one filter and filter order is important, specify the prioritized list of filter 
assignments in the Priority of Filter Assignments portlet preference.

Some portal users might have access to more than one filter assignment. For 
example, you might have an administrative user who can access the AllData 
filter assignment for system management responsibility tasks and can also 
access a filter assignment that limits data to a group of customers.

When a user can access multiple filter assignments, each portlet utilizes only 
one filter assignment at a time for that user. In this case, you might want to 
provide access for some users to change the filter assignment being used for a 
given portlet. The Operations View portlets that utilize filter assignments 
include portlet edit functionality for a user to select the filter assignment that 
is used. Refer to your portal server software documentation for information on 
how to grant or deny access to portlet edit windows.
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Selecting the Filter Assignments for a Portlet

To set the list of filter assignments for a portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, navigate to your Operations 
View portlet within the Portlet Applications folder.

2 In the Priority of Filter Assignments area in the Portlet Edit area of the 
editor pane, click Add.

3 In the Select a Filter Assignment window, select an entry from the list, 
and then click OK.

4 To change the relative position of a filter assignment, select the filter 
assignment, and then click Move Up or Move Down until the filter 
assignment is in the desired position.

5 To remove the AllData filter assignment that was in the initial 
configuration, select AllData, and then click Remove.

6 After you have completed filter assignment selection, click Save.

Removing Filter Assignments from a Portlet

To remove a filter assignment from a portlet, follow these steps:

1 In the scoping pane of the Administrator Tool, navigate to your Operations 
View portlet within the Portlet Applications folder.

2 In the Priority of Filter Assignments area in the Portlet Edit area of the 
editor pane, select the filter assignment to delete, and then click Remove.

3 In the Confirm Deletion window, read the message, and then click OK.

4 Click Save.
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Advanced Topic: Defining a Customer Model Outside 
of the Administrator Tool

You can develop a program that provides a mapping from an arbitrary data 
store or provisioning system to the required Operations View customer model 
format. Operations View is capable of receiving content for the customer 
model from any source that can produce XML content that adheres to the 
Operations View customer model DTD defined in the following file:

• Windows: install_dir\data\conf\dashboard\opview\share\
organizations\SimpleCustomerModel.dtd

• UNIX: /var/opt/OV/conf/dashboard/opview/share/organizations/
SimpleCustomerModel.dtd

The DTD provides a mechanism for remote reporting of errors. If the program 
encounters an error or warning, it can report those along with any customer 
model data, and these errors are added to the appropriate Operations View log 
file. For example, the program could return:

<SimpleCustomerModel>
   <Error msg="The database is currently unavailable"/>
</SimpleCustomermodel>

As an example of a program that creates a customer model source, consider a 
database of customers and their related managed resources. A perl CGI script 
named getMyCustomerData.pl is installed on a web server, 
customerdb.generic.net, and the URL to that script is
http://customerdb.generic.net/cgi-bin/getMyCustomerData.pl.

The perl CGI script could contain some code similar to the following example:

#!/usr/local/bin/perl

print "content-type: text/xml\n\n";
print "<?xml version=\"1.0\" encoding=\"UTF-8\" ?>\n";
print "<!DOCTYPE SimpleCustomerModel PUBLIC \"SimpleCustomerModel\" 
\"http://server.co.com/SimpleCustomerModel.dtd\">\n\n";
print "content-type: text/xml\n\n";
print "<SimpleCustomerModel>";
@orgs = getOrganizationsFromDb();
foreach org (@orgs) {
      print "<Organization name=\"$org\">"
      outputOrganizationData($org);
      print "</Organization>"
print "</SimpleCustomerModel>\n";
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In this example, the perl CGI script named outputOrganizationData 
outputs the customer-to-resource mappings wrapped in XML code required by 
Operations View.
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Advanced Topic: Importing a Customer Model Source 
into the Operations View Configuration

Operations View can be configured to read data from a local file, or any 
arbitrary URL that is accessible from the Operations View server. The URL 
can be a servlet, CGI, or other technology that returns XML content via HTTP.

The customer model source to be created in the Operations View configuration 
must be in the following directory:

• Windows: install_dir\data\conf\dashboard\opview\share\
organizations

• UNIX: /var/opt/OV/conf/dashboard/opview/share/organizations

To specify that Operations View should use a customer model source that is 
created and maintained outside of the Administrator Tool, follow these steps:

1 In the Administrator Tool, click File→ New→ Customer Model URL.

2 In the Add New Customer Model URL window, enter the URL to your 
custom customer model source. Include the protocol (for example
http:// or file:///) at the beginning of the URL.

The URL may also include parameters. For example, you could invoke a 
perl script differently from multiple portal servers as follows:

• URL on portal server 1:

http://customerdb.generic.net/cgi-bin/getMyCustomerData.pl?server=one

• URL on portal server 2:

http://customerdb.generic.net/cgi-bin/getMyCustomerData.pl?server=two
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Next Steps

When the Operations View portlets are correctly configured, deploy the portlet 
application to the portlet server as described in Chapter 11, Deploying a 
Portlet Application.
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13 Configuring Operations View to Run in 
a Wireless Environment
You can use several of the Operations View portlets to display data on 
web-ready cell phones that support a WAP browser:

• NNM Network Health (OVNNMHealth)

• NNM Alarms (OVNNMAlarms)

• OVO Messages (OVOMessages)

• HP OpenView Service Navigator Service Health (OVSNSvcHealth)

• HP OpenView Service Navigator Service Cards (OVSNCards)

• Bookmarks (OVBookmarks)
 139



HP Operations Dashboard Operations View Administrator Guide Version 2.10
Configuring Jetspeed for WAP Enabled Portlets

Before configuring the Jetspeed portal server, create and deploy one or more 
WAP enabled portlets mentioned above using the Operations View 
Administrator tool. When you create WAP enabled portlets using the 
Administrator tool, make sure portlet name is not changed. 

Operations Dashboard provides you a default psml page for WAP for admin 
user. If you want to provide WAP access to any other user, copy this default 
WAP psml page to that user’s profile.

After creating the WAP enabled portlets from Operations View Administrator 
tool, perform the following steps to configure Jetspeed.

1 Go to 
<installdir>\nonOV\dashboard\jetspeed\2.1\webapps\jetspeed\WEB-I
NF\pages\_user\admin

2 Copy the _mediatype directory to the required user directory.

3 Open the default-page.psml file located at 
<installdir>\nonOV\dashboard\jetspeed\2.1\webapps\jetspeed\WEB-I
NF\pages\_user\<USERNAME>\_mediatype\wml.

USERNAME is the name of the user account for which you have copied 
the default-page.psml file.

<?xml version="1.0" encoding="UTF-8"?>

<page id="/_user/admin/_mediatype/wml/default-page.psml" 
hidden="false">

    <title>WAP</title>

    <short-title>WAP</short-title>

    <defaults layout-decorator="wap" 
portlet-decorator="clear"/>

    <fragment id="a-wap1" type="layout" 
name="jetspeed-layouts::VelocityOneColumn">

        

    </fragment>

</page>
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4 Edit the default-page.psml to add WAP enabled portlets that you have 
created and deployed from the Operations View Administrator tool.

<?xml version="1.0" encoding="UTF-8"?>

<page id="/_user/admin/_mediatype/wml/default-page.psml" 
hidden="false">

    <title>WAP</title>

    <short-title>WAP</short-title>

    <defaults layout-decorator="wap" 
portlet-decorator="clear"/>

    <fragment id="a-wap1" type="layout" 
name="jetspeed-layouts::VelocityOneColumn">

<fragment id="" type="portlet"

            name="<ApplicationName>::<PortletName>">

        </fragment>

</fragment>

</page>

Where ApplicationName and PortletName are the name of the deployed 
application and portlet respectively. You need to add seperate fragment 
tag for each portlet that you want to see on your WAP enabled device.

5 Save and close the default-page.psml file.
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Accessing WAP Enabled Portlets on a WAP Device

After configuring JetSpeed for the WAP enabled portlets, perform the 
following steps to access information on your WAP device.

1 Open the WAP browser on your handheld device.

2 Enter the URL to connect to the JetSpeed portal server.

3 Enter the user name and password.

After authentication, you can see the configured portlets on your handheld 
device.

4 Select the portlet for which you want to view data. Drilldown and images 
are not supported on the handheld device.

Operations View uses WAP 2.0 protocol for WAP support. The WAP support is 
available only in JetSpeed.
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Jetspeed Processes

The Jetspeed portal server processes are incorporated into the system startup 
and shutdown procedures and should always be running.

To test whether the Jetspeed processes are running correctly, in a supported 
web browser, enter the following URL:

http://hostname:18080/jetspeed

Where hostname is the fully qualified name of the computer on which 
Operations View is installed. If the web browser is running on the same 
computer as Operations View, you can use localhost for the hostname.

18080 is the default port for the Jetspeed portal server. If you changed the 
Jetspeed port number during Operations Dashboard installation, use the 
appropriate value in place of the default.

If you see an error message in the web browser such as “The Page cannot be 
displayed,” it is probable that the Jetspeed processes are not running. Start 
the Jetspeed processes, and then reload the portal view to resolve this 
problem.

Starting Jetspeed

To start the Jetspeed processes, follow the procedure appropriate to the 
operating system of the Dashboard server:

• Windows: Start the HP Operations Dashboard PortalServer service.

• HP-UX: /sbin/init.d/ovdshbdjetspeed start

• Solaris: /etc/init.d/ovdshbdjetspeed start
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Stopping Jetspeed

To stop the Jetspeed processes, follow the procedure appropriate to the 
operating system of the Dashboard server:

• Windows: Stop the HP Operations Dashboard PortalServer service.

• HP-UX: /sbin/init.d/ovdshbdjetspeed stop

• Solaris: /etc/init.d/ovdshbdjetspeed stop

Restarting Jetspeed

To restart the Jetspeed processes, follow the procedure appropriate to the 
operating system of the Operations View server:

• Windows: Stop, and then start the HP Operations Dashboard PortalServer 
service.

• HP-UX: /sbin/init.d/ovdshbdjetspeed restart

• Solaris: /etc/init.d/ovdshbdjetspeed restart
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Portal Server Port Conflicts

Port conflicts are a common problem when multiple software products all try 
to use the same port for communication. The end result is typically failure of 
one or more software products.

The installed HP Operations Dashboard Jetspeed portal server uses the 
following default port numbers:

• Tomcat/Jetspeed Non-SSL Port: 18080

• Tomcat/Jetspeed Shutdown Port: 18005

The BEA WebLogic portal server software uses port 7001 by default.

You can encounter port conflicts if you have other products installed, such as 
another Tomcat web server, or a product that uses a web server. User-specific 
custom applications might also be using the same ports.

Avoiding Port Conflicts

Use the netstat -a command to display the currently active ports. This 
command displays a list of all currently active connections and listening ports.

If the netstat results show that the default ports are currently being used by 
other software, modify the port settings during installation. Near the end of 
the Operations Dashboard installation, the HP Operations Dashboard 
Jetspeed Port and Proxy Settings window lists the currently configured ports 
for Apache Jetspeed. Modify the ports if necessary, and then click OK.

Identifying Operations View Port Conflicts

After installing Operations View and configuring and deploying your portlets, 
if you are unable to see your Operations View portlets or to save portlet 
preferences, you are most likely experiencing a port conflict.

If you are running Jetspeed, HP recommends that you use the following steps 
to identify a port conflict problem:

1 Ensure that the Jetspeed process are running.

• Windows: Verify that the HP Operations Dashboard PortalServer 
service is started.
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• UNIX: Use either the ps or ptree commands to verify that the 
Jetspeed daemon is running.

2 Check the log files to determine if any error messages that indicate a port 
conflict have been logged.

The Jetspeed logs are located in the following directory:

• Windows: <install_dir>\nonOV\dashboard\jetspeed\2.1\logs

• UNIX: /opt/OV/nonOV/dashboard/jetspeed/2.1/logs

If you are running BEA WebLogic, consult the BEA documentation to resolve 
port conflicts.

Resolving Operations View Port Conflicts

If you identify one or more port conflicts after installing Operations View, you 
can resolve the conflicts by using the Operations View Administrator Tool. 

1 In the Administrator Tool, click Tools→ Set Jetspeed Ports and Proxy 
Settings.

The HP Operations View Jetspeed Port and Proxy Settings window opens. 
This window allows you to modify the Jetspeed port.

2 Enter port numbers that are unique for your server and the associated 
applications.

• When modifying the Jetspeed non-SSL port, remember that this port 
change affects how you start Jetspeed in your web browser. For 
example, if you change the port to 8085, in your browser start 
Jetspeed using http://localhost:8085/jetspeed.

• Modifying the Jetspeed shutdown port should be transparent to the 
end user.

3 Click OK to close the window.

4 Click OK to restart the services or daemons.

The Jetspeed must be restarted before the port changes take effect.
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Memory Usage

Memory issues can be common when dealing with a large deployment or a 
large amount of data. The two locations where you might need to increase the 
amount of memory that is available for the Java processes are as follows:

• Operations View Administrator Tool

If you are migrating a large HP OpenView Service Information Portal 
version 3.2 deployment or have a large number of portlets that you have 
created, you might need to increase the amount of memory that is 
available to the Administrator Tool.

• Portal Server

If you have deployed a large number of portlets to your portal server or the 
deployed portlets consume a large amount of memory to process, you 
might need to increase the portal server memory. This situation applies to 
both the Jetspeed Portal Server and the BEA WebLogic Portal Server.

The section describes the steps to adjust memory settings for Operations View 
processes.

Adjusting the Administrator Tool Process Memory

To change the amount of memory available to the Administrator Tool, follow 
these steps:

1 Stop the Administrator Tool if it is running.

2 In any text editor, open the Administrator Tool startup script. To edit this 
file you must have administrative privileges on Windows and root access 
on UNIX:

• Windows: <install_dir>/bin/ovopviewadmingui.bat

• UNIX: /opt/OV/bin/ovopviewadmingui

3 Modify the maximum heap size java property:

• Windows: Locate and modify the value of MAX_HEAP_SIZE. For 
example, the following line changes the maximum heap size to 256M:

SET MAX_HEAP_SIZE=256M
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• UNIX: Locate the following line and append the -Xms and -Xmx 
settings. For example, the following line changes the initial and 
maximum heap sizes to 128M and 512M, respectively:

$OV_JAVA -classpath $OPVIEW_CLASSPATH 
com.hp.ov.portal.admingui.MainJFrame -f $OPVIEW_PROPERTIES 
-Xms=128M -Xmx=512M $* &

4 Restart the Administrator Tool.

Adjusting the Jetspeed Portal Server Process Memory

To adjust the amount of memory available to the Jetspeed portal server, follow 
these steps:

1 Stop the portal server processes, if they are running.

• Windows: Stop the HP Operations Dashboard PortalServer service.

• HP-UX: /sbin/init.d/ovdshbdjetspeed stop

• Solaris: /etc/init.d/ovdshbdjetspeed stop

2 In any text editor, open the process script. To edit this script you must 
have Administrator privileges on Windows and root access on UNIX:

• Windows:
<OvInstallDir>\nonOV\dashboard\jetspeed\2.1\bin\catali
na.bat

Modify the -Xms and -Xmx settings for the Jetspeed service. The 
following example sets the initial and maximum heap sizes to 128M 
and 512M, respectively:

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx256m

rem Guess CATALINA_HOME if not defined

set CURRENT_DIR=%cd%

if not "%CATALINA_HOME%" == "" goto gotHome

set CATALINA_HOME=%CURRENT_DIR%

if exist "%CATALINA_HOME%\bin\catalina.bat" goto okHome

cd ..

set CATALINA_HOME=%cd%
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cd %CURRENT_DIR%

:gotHome

• UNIX: 
/opt/OV/nonOV/dashboard/jetspeed/2.1/bin/catalina.sh

Modify the JAVA_OPTS environment variable to add the new memory 
settings. The following example sets the JAVA_OPTS variable to 
include setting the initial and maximum heap sizes to 128M and 
512M, respectively.

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx256m

3 Restart the Jetspeed processes:

• Windows:

— Uninstall the Jetspeed service:

<install-dir>\lbin\dashboard\

ovduninstalljetspeedservice-j2.bat uninstall

Uninstalling the service is necessary to reset registry entries that 
store the startup arguments.

— Install the Jetspeed service:

<install-dir>\lbin\dashboard\ovdinstalljetspeedserv
ice-j2.bat install

— Installing the service does not start the services.

• HP-UX: /sbin/init.d/ovdshbdjetspeed start

• Solaris: /etc/init.d/ovdshbdjetspeed start

Adjusting the BEA WebLogic Portal Server Process Memory

Refer to the documentation from BEA Web Logic for information on this 
topic.
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Portlet Logging and Tracing

Operations View provides several log files to help you troubleshoot problems 
with the Administrator Tool, the Migration Wizard, and the Operations View 
portlets. The log files contains warning and error entries.

• A warning indicates that a problem occurred but the Operations View 
portlet was able to continue, possibly using a default value or some 
assumption. The warning is issued because the assumption may have 
been wrong and you might want to fix the problem.

• An error indicates a problem that prevents the Operations View portlet 
from completing a task.

Portlet tracing is primarily intended for use by HP support. It supplies a large 
amount of extra data that can help debug portlet problems.

The Operations View log and trace files are named with the format 
base_name.x.x.log.

• base_name indicates the type of data in the log file.

• x.x indicates the placement in the log file sequence. Log files roll to the 
configured size and then start a new log file. Up to two files are created 
before the first file is reused. This is a Java virtual machine setting that is 
not configurable.

Table 8 lists the types of Operations View log files and describes their 
contents.
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The Operations View log and trace files are located in the following directory:

• Windows: <install_dir>\data\log\dashboard\opview

• UNIX: /var/opt/OV/log/dashboard/opview

Viewing Log Files

To view the Operations View log files, use any text editor or viewer to open the 
log files.

Setting Log and Trace Level

To set the logging and tracing level, in the Administrator Tool click Tools→ 
Select Log Level, and then click the level you want. If the portal is running, it 
might take a few minutes for the new setting to take effect.

Table 8 Operations View Log and Trace Files

File Name Contents

opview.x.x.log Portlet error and warning messages

opview_trace.x.x.log Portlet error, warning, tracing, and 
verbose messages

opviewadmin.x.x.log Administrator Tool error and 
warning messages

opviewadmin_trace.x.x.log Administrator Tool error, warning, 
tracing, and verbose messages

Migration.x.x.log Migration Wizard error, warning, 
tracing, and verbose messages

This log level setting applies to the opview and opviewadmin files only. The 
Migration log files always contain all possible messages from the Migration 
Wizard.
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Increasing the Size of the Log File

The default size for a log file is approximately 10 MB. When that size is 
reached, the log file rolls to the next file in the sequence. If that next file 
already exists, the data it contains is lost when the newer logging begins.

To set the maximum log size, in the Administrator Tool click Tools→ Set 
Maximum Log Size, and then enter the new file size.
152 Chapter 14



Version 2.10 HP Operations Dashboard Operations View Administrator Guide
Validating XML Files

Operations View provides the ovopviewxmlvalidate command to check an 
XML file for correctness. The syntax of an XML file is considered correct if it is 
both well-formed and valid. An XML file is “well-formed” if it conforms to a 
minimal set of rules defined for all XML documents. It is “valid” if it conforms 
to the DTD listed at the beginning of the XML file. This command uses the 
same XML parser as Operations View, so if the file passes 
ovopviewxmlvalidate, it will work in the Administrator Tool.

For the ovopviewxmlvalidate command to work from outside the bin 
directory, add the following content to your PATH variable: 

• Windows: <install_dir>\bin

• UNIX: /opt/OV/bin

For XML files that reference a DTD file residing in the same directory, correct 
usage of the ovopviewxmlvalidate command is as follows:

ovopviewxmlvalidate -v <xml_filename>

If a file does not reference a DTD or if its DTD is unavailable, 
ovopviewxmlvalidate can be used to determine if the file is well-formed 
without checking for validity as defined by the DTD. The form of this 
command is as follows:

ovopviewxmlvalidate -V <xml_filename>

Avoiding Loss of Changes

Do not edit the XML configuration files while the Administrator Tool is 
running.

HP does not support the direct editing of the Administrator Tool configuration 
files.
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A Operations View Portlets
This appendix lists all of the portlets that are supplied with HP Operations 
Dashboard Operations View. The three types of supplied portlets are as 
follows: 

• HP OpenView product portlets

• General content portlets

• HP OpenView Integration portlet
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HP OpenView Product Portlets

HP OpenView product portlets connect to HP OpenView management 
products to collect management data and display that data to a user. Table 9 
lists these portlets and names the versions of each management product that 
each portlet supports.

Table 9 HP OpenView Product Portlets and Supported Management Products

Operations View Portlet Title and Description
HP OpenView Management 
Product and Supported Versions

• HP OV NNM Topology
HP OpenView Network Node Manager Topology 
Portlet. Provides access to NNM topology maps.

• HP OpenView Network Node 
Manager versions 6.41 or 7.5

• HP OpenView Customer Views 
version 1.2 for NNM versions 6.2 
or 6.4

For information on how to configure 
these portlets, see the Operations 
View Integration Guide: NNM.

• HP OV NNM Alarms
HP OpenView Network Node Manager Alarms 
Portlet. Provides access to NNM alarms.

• HP OV NNM Network Health
HP OpenView Network Node Manager Network 
Health Portlet. Provides access to status information 
of network devices within NNM.

• HP OV NNM MPLS
HP OpenView NNM MPLS Portlet. Provides access 
to NNM MPLS data.
NOTE: This portlet is shipped in a different WAR 
file from the other HP OpenView product portlets. 
For information on how to enable this portlet, see the 
Operations View Integration Guide: NNM.

• HP OV NNM Dynamic View
HP OpenView NNM Dynamic View Portlet. Provides 
access to NNM dynamic views data.
NOTE: This portlet is shipped in a different WAR 
file from the other HP OpenView product portlets. 
For information on how to enable this portlet, see the 
Operations View Integration Guide: NNM.

NNM Dynamic Views for NNM 
version 7.51
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• HP OVO Messages
HP OpenView Operations Messages Portlet. 
Provides access to messages within OVO.

• HP OpenView Operations for 
UNIX versions 8.0, 8.1, 8.11, or 
8.20

• HP OpenView Service Navigator 
versions 8.0, 8.1, or 8.11 value 
pack

• HP OpenView Operations for 
Windows version 7.21 or 7.5

• HP OpenView Interconnect 
version 3.1 and 3.4 (for HP-UX 
11.23 Itanium)

For information on how to configure 
these portlets, see the Operations 
View Integration Guide: OVO and 
OVSN.

• HP OVSN Service Graph
HP OpenView Service Navigator Service Graph 
Portlet. Provides a hierarchical view of the elements 
that contribute toward the success of your services 
within Service Navigator.

• HP OVSN Service Browser
HP OpenView Service Navigator Service Browser 
Portlet. Provides access to a list of the currently 
defined top-level services or selected services within 
Service Navigator.

• HP OVSN Service Health
HP OpenView Service Navigator Service Health 
Portlet. Provides access to health information of 
selected services within Service Navigator.

• HP OVSN Service Cards
HP OpenView Service Navigator Service Cards 
Portlet. Provides a view to the most important 
information about a service within Service 
Navigator.

• HP OV Internet Services
HP OpenView Internet Services Portlet. Provides a 
snapshot of the health of the OVIS services.

• HP OpenView Internet Services 
versions 5.2, 6.0, 6.1, or 6.2

For information on how to configure 
these portlets, see the Operations 
View Integration Guide: OVIS.

• HP OV Internet Services Dashboard
HP OpenView Internet Services Dashboard Portlet. 
Provides a summary of OVIS services with drill 
down into trend, alarm, and graphs.

Table 9 HP OpenView Product Portlets and Supported Management Products 

Operations View Portlet Title and Description
HP OpenView Management 
Product and Supported Versions
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• HP OV Performance Manager
HP OpenView Performance Manager Portlet. 
Provides access to performance reports available 
within OVPM.

• HP OpenView Performance 
Manager 5.0 or 6.0

For information on how to configure 
this portlet, see the Operations View 
Integration Guide: OVPM.

• HP OV Service Desk for Specialists
HP OpenView Service Desk for Specialists Portlet, 
based on the HP OpenView Integration Portlet. 
Provides access to the lists of current service calls, 
incidents, problems, changes, and work orders in 
Service Desk.

• HP OpenView Service Desk 4.0 or 
4.5

For information on how to configure 
these portlets, see the Operations 
View Integration Guide: OVSD, 
OVPI, and OVR.• HP OV Service Desk

HP OpenView Service Desk Portlet, based on the 
HP OpenView Integration Portlet. Provides access to 
the list of current service calls in Service Desk.

• HP OV Performance Insight Browser
HP OpenView Performance Insight Browser Portlet, 
based on the HP OpenView Integration Portlet. 
Provides access to the reports directory structure 
available in the current user’s Performance Insight 
view.

• HP OpenView Performance 
Insight version 5.1 or 5.2

For information on how to configure 
these portlets, see the Operations 
View Integration Guide: OVSD, 
OVPI, and OVR.• HP OV Performance Insight

HP OpenView Performance Insight Portlet, based on 
the HP OpenView Integration Portlet. Provides 
access to pre-selected OVPI reports.

Table 9 HP OpenView Product Portlets and Supported Management Products 

Operations View Portlet Title and Description
HP OpenView Management 
Product and Supported Versions
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Before you can display data through these portlets, you must establish a 
connection between Operations View and the management products. For more 
information, see Chapter 5, Configuring Operations View for Your 
Management Products.

For detailed information on configuring and using these portlets, see the 
separate product integration manuals located in the following directory:

• Windows: install_dir\paperdocs\dashboard\opview

• UNIX: /opt/OV/paperdocs/paperdocs/dashboard/opview

For information on creating your own online help topic for any of the supplied 
portlets, see Adding and Customizing Portlet Help Topics on page 76.

• HP OV Reporter: Reports
HP OpenView Reporter Reports, based on the 
HP OpenView Integration Portlet. Provides access to 
all reports within OVR.

• HP OpenView Reporter 3.0, 3.5, 
or 3.6

For information on how to configure 
these portlets, see the Operations 
View Integration Guide: OVSD, 
OVPI, and OVR.

• HP OV Reporter: NNM Reports
HP OpenView Reporter NNM Reports Portlet, based 
on the HP OpenView Integration Portlet. Provides 
access to NNM reports within OVR.

• HP OV Reporter: OVO Reports
HP OpenView Reporter OVO Reports Portlet, based 
on the HP OpenView Integration Portlet. Provides 
access to OVO reports within OVR.

• HP OV Reporter: OVPA Reports
HP OpenView Reporter OVPA Reports Portlet, based 
on the HP OpenView Integration Portlet. Provides 
access to OVPA reports within OVR.

Table 9 HP OpenView Product Portlets and Supported Management Products 

Operations View Portlet Title and Description
HP OpenView Management 
Product and Supported Versions
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General Content Portlets

Operations View includes two portlets that deliver general content that is not 
related to management data:

• Operations View Bookmarks portlet: A way of integrating website 
links into the portal view. See Chapter 7, Configuring the Operations View 
Bookmarks Portlet.

• Operations View Message Board portlet: A way of getting important 
information to end users through the portal view. See Chapter 8, 
Configuring the Operations View Message Board Portlet.

• Operations View SQL Portlet: A way of displaying data from a 
configured database through the portal view. See Chapter 9, Configuring 
the Opeartions View SQL Portlet.

For information on creating your own online help topic for any of the supplied 
portlets, see Adding and Customizing Portlet Help Topics on page 76.

HP OpenView Integration Portlet

The HP OpenView Integration portlet provides a non-programmatic way to 
quickly incorporate your existing web applications, reports, and other data 
into the Operations View configuration. You can use the HP OpenView 
Integration portlet to create your own full-featured portlets that can be added 
and customized through the portal view, extending the functionality of 
Operations View without writing portal-specific Java code.

For information on using the HP OpenView Integration portlet to develop 
your own portlets, see Chapter 10, Configuring the HP OpenView Integration 
Portlet.

For information on creating your own online help topic for any of the supplied 
portlets, see Adding and Customizing Portlet Help Topics on page 76.
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B Portal View Planning Worksheets
This appendix provides worksheets that you can use while planning your 
HP Operations Dashboard Operations View portal views. For information on 
the decisions represented by each worksheet, see the Chapter 3, Planning 
Your Operations View Portal Content. For information on implementing the 
Operations View configuration, see the appropriate chapters in this manual 
and the integration manuals for the individual HP OpenView management 
products.

This appendix contains the following sections:

• HP OpenView Product Integrations Planning Worksheet on page 162

• General Content Planning Worksheet on page 167

• Custom Applications and Data Planning Worksheet  on page 168

• Portal Server Roles Planning Worksheet on page 169

• Portal View Layout Planning Worksheet on page 170

• Customer Organizations Planning Worksheet on page 171

• Filter Assignments Planning Worksheet on page 172

• Portal Server Authentication Planning Worksheet on page 174

While some of the information collected on these planning worksheets 
pertains to the configuration of your portal server product, these worksheets 
do not contain enough information for configuring the portal server. Please 
refer to the portal server documentation for complete information on portal 
server configuration.
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HP OpenView Product Integrations Planning Worksheet

Portlet Management Stations and 
Help File (if customized)

Filter Assignments

Portlet name:
• NNMTopology
 
Portlet title:
• HP OV NNM Topology
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• NNMAlarms
 
Portlet title:
• HP OV NNM Alarms
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• NNMHealth
 
Portlet title:
• HP OV NNM Network 

Health
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• NNMMPLS
 
Portlet title:
• HP OV NNM MPLS
 

Management stations:

Custom help file:

Filter assignments:
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Portlet name:
• OVOMessages
 
Portlet title:
• HP OVO Messages
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVSN ServiceGraph
 
Portlet title:
• HP OVSN Service Graph
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVSN Browser
 
Portlet title:
• HP OVSN Service 

Browser
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVSNSvcHealth
 
Portlet title:
• HP OVSN Service Health
 

Management stations:

Custom help file:

Filter assignments:

Portlet Management Stations and 
Help File (if customized)

Filter Assignments
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Portlet name:
• OVSNCards
 
Portlet title:
• HP OVSN Service Cards
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVIS
 
Portlet title:
• HP OV Internet Services
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVIS

Dashboard
 
Portlet title:
• HP OV Internet Services 

Dashboard
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVPM
 
Portlet title:
• HP OV Performance 

Manager

Management stations:

Custom help file:

Filter assignments:

Portlet Management Stations and 
Help File (if customized)

Filter Assignments
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Portlet name:
• ServiceDesk4Specialists
 
Portlet title:
• HP OV Service Desk for 

Specialists
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• ServiceDesk
 
Portlet title:
• HP OV Service Desk
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• PerfInsightBrowser
 
Portlet title:
• HP OV Performance 

Insight Browser
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• PerfInsight
 
Portlet title:
• HP OV Performance 

Insight
 

Management stations:

Custom help file:

Filter assignments:

Portlet Management Stations and 
Help File (if customized)

Filter Assignments
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Portlet name:
• OVR_Reports
 
Portlet title:
• HP OV Reporter
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVR_NNMReports
 
Portlet title:
• HP OV Reporter for NNM 

Reports
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVR_OVOReports
 
Portlet title:
• HP OV Reporter for OVO 

Reports
 

Management stations:

Custom help file:

Filter assignments:

Portlet name:
• OVR_OVPAReports
 
Portlet title:
• HP OV Reporter for OVPA 

Reports

Management stations:

Custom help file:

Filter assignments:

Portlet Management Stations and 
Help File (if customized)

Filter Assignments
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General Content Planning Worksheet

Group Group Content

Bookmark group title:

Bookmark group name:

Bookmarks
(specify title and URL)

Bookmark group title:

Bookmark group name:

Bookmarks
(specify title and URL)

Message directory name: Messages
(specify message name and filename)

Message directory name: Messages
(specify message name and filename)
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Custom Applications and Data Planning Worksheet 

Custom Portlet 
Name Portlet Content Portlet Provider

Portlet Location 
and Development 
Status

   

   

   

   
168 Chapter B



Version 2.10 HP Operations Dashboard Operations View Administrator Guide
Portal Server Roles Planning Worksheet

Portal Role Name Portal Views Filter Assignments
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Portal View Layout Planning Worksheet 

Portal View Specifications
Portal view name: 

Look and feel: 

Default page: 

Page Column Portlets Access

Page name:

# of columns:
 
 
 
 
 

1   

2   

3   

4   

Page name:

# of columns:
 
 
 
 
 

1   

2   

3   

4   
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Customer Organizations Planning Worksheet

Customer model source name:

Organization Service 
Lists and 
External 
References

Node Lists 
and 
External 
References

Interface 
Lists and 
External 
References

NNM Topology 
Object Lists 
and External 
References

VPNs

Organization 
name:
 
Display string:
 
Service level:
 
External key:
 

Organization 
name:
 
Display string:
 
Service level:
 
External key:
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Filter Assignments Planning Worksheet

Filter assignment package file name:

Filter 
Assigments Security Constraints Data Presentation

AllData
 
 
 

_X_ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

_X_ All data
__ No data
__ Data for the organizations:

NoData
 
 
 

__ All authenticated users
_X_ All users (including 
anonymous)
__ Users from the portal roles:

__ All data
_X_ No data
__ Data for the organizations:

__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:

__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:
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__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:

__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:

__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:

__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:

__ All authenticated users
__ All users (including anonymous)
__ Users from the portal roles:

__ All data
__ No data
__ Data for the organizations:
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Portal Server Authentication Planning Worksheet

Use This 
Provider?

Authentication 
Provider Description

 HP Select Identity 
(for BEA WebLogic 
only)

Provides centralized management of users' identities and 
access rights over their complete life cycle, from initial 
registration through approval, provisioning, ongoing 
maintenance, termination, and auditing. 
For information, see the whitepaper Identity 
Management in Portals: Integrating HP OpenView 
Select Identity with BEA WebLogic Portal.

 BEA WebLogic 
Server

WebLogic offers several authentication providers:
• WebLogic Authentication
• LDAP Authentication
• Realm Adapter Authentication
• WebLogic Identity Assertion
For information, see the topic Security in the BEA 
WebLogic documentation.

 Jetspeed Server Jetspeed offers an authentication provider that uses a 
relational database system that can be configured to use 
LDAP.
For information, see the topic Security in the Apache 
Jetspeed documentation.

 Other security 
provider

For links to portal solutions web sites, 
see Custom Applications and Data Planning Worksheet .

 Customer security 
provider

For information of the portal server APIs for integrating 
a customer authentication provider with the portal 
server, see:
• Jetspeed: http://portals.apache.org/jetspeed-1/

security.html
• BEA WebLogic: http://edocs.bea.com/wlp/docs81/

adminportal/help/OV_Security.html
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C HP OpenView Integration Portlet DTD
HP Operations Dashboard Operations View provides the HP OpenView 
Integration portlet that you can customize. Each HP OpenView Integration 
portlet instance is configured by an XML file that defines the content for that 
portlet instance. The XML syntax is specified in the OVGeneric.dtd file.

The HP OpenView Integration portlet configuration files and the 
OVGeneric.dtd file are located in the following directory:

• Windows: <data_dir>\conf\dashboard\opview\share\
portlet-config\generic

• UNIX: /var/opt/OV/conf/dashboard/opview/share/
portlet-config/generic

You can organize your XML configuration files within subdirectories of the 
generic directory. In this case, verify that the document type definition (DTD) 
declaration in each XML file points to the correct location of the 
OVGeneric.dtd file.

This appendix contains the following sections:

• HP OpenView Integration Portlet DTD File on page 177 shows the DTD 
for the HP OpenView Integration portlet.

• The following sections describe the DTD elements and attributes:

— Generic Element Attributes on page 180

— Submodule Element Attributes on page 180

— TitleBar Element Attributes on page 182

— File Element Attributes on page 183

— Command Element Attributes on page 185

— Url Element Attributes on page 187

— XmlTranslation Element Attributes on page 190
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— EmbeddedHtml Element Attributes on page 191

— GlobalParms Element Attributes on page 192

— TextParm Element Attributes on page 193

— OptionParm Element Attributes on page 194

— Option Element Attributes on page 195
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HP OpenView Integration Portlet DTD File

This section presents the entire contents of the OVGeneric.dtd file that is 
used to interpret the HP OpenView Integration portlet configuration files.

<!-- OVGeneric.dtd -->
<!-- Copyright 2000-2005 Hewlett-Packard Development Company, L.P.  -->

<!ELEMENT Generic (GlobalParms?, Submodule+)>
<!ELEMENT GlobalParms ((TextParm*, OptionParm*)*)>
<!ELEMENT Submodule (TitleBar?, (Command? | File? | Url? | XmlTranslation?), 
EmbeddedHtml?)>
<!ELEMENT TitleBar EMPTY>
<!ATTLIST TitleBar
    title CDATA #IMPLIED
    titleAnchorUrl CDATA #IMPLIED
    titleAnchorText CDATA #IMPLIED
    status CDATA #IMPLIED
    statusImageUrl CDATA #IMPLIED
    statusImageAltText CDATA #IMPLIED
>
<!-- EmbeddedHtml - this is HTML that will be embedded as it is at the end of 
the extension i.e. -->
<!-- below command output or file. Notice also that Submodule may display only                 
-->
<!-- Embedded HTML if an Submodule doesn't containt Command, File nor Url    
-->
<!ELEMENT EmbeddedHtml EMPTY>
<!ATTLIST EmbeddedHtml
    data CDATA #IMPLIED
>
<!ELEMENT Command ((TextParm*, OptionParm*)*)>
<!ATTLIST Command
    commandLine CDATA #REQUIRED
    type CDATA "text/plain"
    expires CDATA "0"
    stripHtmlHeader (yes | YES | no | NO | 0 | 1) "no"
>
<!ELEMENT File ((TextParm*, OptionParm*)*)>
<!ATTLIST File
    fileName CDATA #REQUIRED
    type CDATA "text/plain"
    encoding CDATA "UTF-8"
    displayFileInfo (yes | YES | no | NO | 0 | 1) "no"
    stripHtmlHeader (yes | YES | no | NO | 0 | 1) "no"
>
<!-- If displayMethod is "inline" or "anchor" then to proxy or not depends 
"proxy" attribute. -->
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<!-- If displayMethod is "embedded" then we are always proxing (proxy should 
be set           -->
<!-- to "yes", but actually portal ignores this attribute.                                    
-->
<!-- auth, loginUrl and handshake are used only if proxying is being done.                    
-->
<!-- If auth is set, but loginUrl is not, web server authentication is 
performed.  In this    -->
<!-- case, auth should be of the form "user:password".                                        
-->
<!-- If both auth and loginUrl are set, authentication is performed via the 
loginUrl, which   -->
<!-- specifies the URL for a login page.  In this case, auth should contain 
the               -->
<!-- URL parameters necessary to perform the login, separated by "&amp;".  
Usually the        -->
<!-- parameter string contains some sort of user and password specification.                  
-->
<!-- If handshake is set to "yes" then a handshake is done initially ie. the 
handshakeUrl is  -->
<!-- accessed. If any cookie is available in the response then this cookie is 
used when       -->
<!-- making further requests to the website. Handshake only works for web 
server              -->
<!-- authentication.                                                                          
-->

<!-- The "windowName" attribute identifies the name of the window into which 
the content of   -->
<!-- the Url should be displayed.                                                             
-->
<!-- The "showAsButton" attribute applies only if displayMethod is "anchor".  
It causes the   -->
<!-- Url to be shown as a button at the bottom of the module instead of a 
link.               -->
<!ELEMENT Url ((TextParm*, OptionParm*)*)>
<!ATTLIST Url
    href CDATA #REQUIRED
    displayMethod (inline | anchor | embedded) #REQUIRED
    inlineHeight CDATA "100"
    ifNoIFramesMsg CDATA #IMPLIED
    anchorText CDATA "click here"
    proxy (yes | YES | no | NO | 0 | 1) "no"
    auth CDATA #IMPLIED
    loginUrl CDATA #IMPLIED
    handshake (yes | YES | no | NO | 0 | 1) "no"
    handshakeUrl CDATA #IMPLIED
    windowName CDATA #IMPLIED
    showAsButton (yes | YES | no | NO | 0 | 1) "no"
>
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<!-- "xmlHref" and "xslHref" can be a URL or a file -->
<!-- "type" is a MIME type of the output generated after applying XSL 
transformation to XML data -->
<!--  for example, "type" can be set to "text/plain" or "text/html" -->
<!ELEMENT XmlTranslation ((TextParm*, OptionParm*)*)>
<!ATTLIST XmlTranslation
    xmlHref CDATA #REQUIRED
    xslHref CDATA #REQUIRED
    type CDATA #REQUIRED
>
<!ELEMENT TextParm EMPTY>
<!ATTLIST TextParm
    prompt CDATA #REQUIRED
    name CDATA #REQUIRED
    value CDATA #IMPLIED
>
<!ELEMENT OptionParm (Option+)>
<!ATTLIST OptionParm
    prompt CDATA #REQUIRED
    name CDATA #REQUIRED
    value CDATA #IMPLIED
>
<!ELEMENT Option EMPTY>
<!ATTLIST Option
    name CDATA #REQUIRED
    value CDATA #REQUIRED
>
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Generic Element Attributes

Table 10 list the attributes that can with used with the Generic element.

Submodule Element Attributes

Table 11 list the attributes that can with used with the Submodule element. 
Parameter substitution can be used with the File, Command, Url, and 
XmlTranslation elements as described in Using Variables to Access 
Operations View Data on page 106.

Table 10 Generic Element

 Element Description

Submodule Contains zero or one TitleBar elements, and zero or one of the 
Command, File, Url, or EmbeddedHtml elements.

GlobalParms Defines parameters that apply to all submodules within the 
HP OpenView Integration portlet.

Table 11 Submodule Elements

 Element Description

TitleBar Optional. Displays a gray title bar at the beginning of a 
submodule. Each submodule can have zero or one title bar.

File Optional. Imports a file on your local machine or network. It 
does not access files that require HTTP access. The file can be 
HTML (text/html) or plain text (text/plain).
For more information see The File Content Option on 
page 102.

Command Optional. Displays the output of any executable command that 
generates stdout.
For more information, see The Command Content Option on 
page 101.
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Url Optional. Displays the content of a URL. Using Url, you can 
display the contents of a remote file that requires HTTP 
access, or execute a CGI program.
For more information, see The URL Content Option on 
page 99.

XmlTranslation Optional. Transforms XML data with XSL and displays the 
results. XML and XSLT files can reside on your local machine 
or network, or they can be accessed remotely using HTTP.
For more information, see The XML Translation Content 
Option on page 103.

EmbeddedHtml Optional. Embeds raw HTML. This element can be used by 
itself or in conjunction with the File, Command or Url element, 
in which case the value of EmbeddedHtml is output after the 
processing of theother element. TheEmbeddedHtml element 
must be defined after the other element.
For more information, see The Embedded HTML Content 
Option on page 103.

Table 11 Submodule Elements (cont’d)

 Element Description
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TitleBar Element Attributes

Table 12 list the attributes that can with used with the TitleBar element.

Table 12 TitleBar Attributes

 Attributes Description

title The name displayed in the submodule title bar (e.g., “Billing” 
or “Trouble Tickets”). The value can be either simple text or 
HTML. If HTML is used, characters such as "<" and ">" need 
to be appropriately escaped according the rules for valid 
HTML.

titleAnchorUrl Defines a URL ("http:...") to be accessed through the 
submodule titlebar. The attribute titleAnchorText must also 
be set in order for this attribute to have an effect.

titleAnchorText Defines the text to be placed within the anchor tag and 
displayed in the submodule title bar. The attribute 
titleAnchorUrl must also be set for this to have an effect.

status Status text to be displayed on the right-hand side in the 
submodule title. The value can be either simple text or HTML. 

statusImageUrl Defines a URL ("http:...") of an image to display right 
justified in the submodule title bar.

statusImageAltText Defines alternate text to display for the image.
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File Element Attributes

Table 13 list the attributes that can with used with the File element. 
Parameter substitution can be used with the fileName element as described 
in Using Variables to Access Operations View Data on page 106.

Table 13 File Attributes

 Attributes Description

fileName A required attribute, fileName defines the file that can be 
accessed and displayed. The file must reside on the same 
system or be accessible through the network. The file path can 
be absolute (starting from the root directory) or you can use 
$CONF_DIR to reference files relative to the Operations View 
installation directory. 
Example: 
fileName="/tmp/file.html"

type Indicates the type of file. There are two values for this 
attribute:
• text/plain: The file content is pure ASCII text. In this 

mode, the HP OpenView Integration portlet prefixes the 
file content with the HTML tag <pre> and appends the 
HTML tag </pre> after the file content. This wrapping is 
necessary to support non-HTML files.

• text/html: The file contains HTML text. No wrapping of 
the content is performed.

displayFileInfo This attribute can be set to “yes” in order to display the full 
path to the file and the time when the file was last modified in 
the browser. This information precedes the file content. The 
default value for this attribute is “no.” The default is not to 
display the full path name or modification time. Possible 
values are: yes, no, YES, NO, 0, 1
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stripHtmlHeader This attribute is used to strip the <Head></Head> contents 
before displaying a file. This is useful if the imported file 
contains a <Head> section and the client browser cannot 
handle the reception of multiple <Head> elements (one from 
the portal and one from the file).
When the value of type equals “text/html”, this attribute can 
be set to “yes” to display just the contents of the HTML 
<body> tag. All HTML header information from the file will be 
removed from the output stream. This attribute may need to 
be set if the referenced file contains an entire valid HTML 
document including HTML header information. It may not be 
valid to return more than one set of HTML header tags to the 
browser. It is important to remove the additional tags from the 
referenced file. The default value of this attribute is “no.” 
Possible values are: yes, no, YES, NO, 0, 1
Output from the portal generates a complete HTML document 
including <Html>, <Head>, and <Body> tags. If the output of 
your command generates its own <Html>, <Head>, and <Body> 
tags, you will have more than one each of the <Html>, <Head>, 
and <Body> tags. If this is the case, set stripHtmlHeader to 
“yes.”
The default is set to “no” to allow the functioning of any 
potential scripts that you have placed in the <Head> tag. Be 
aware that a document containing multiple <Html>, <Head>, 
and <Body> tags may cause unpredictable behavior in the 
browser. If a problem arises that you suspect is related to 
header data, change StripHtmlHeader to “yes.”

encoding This attribute indicates the character set the file is encoded in. 
The default value is “UTF-8”. Change the default value if the 
file uses non-ASCII characters.

Table 13 File Attributes (cont’d)

 Attributes Description
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Command Element Attributes

Table 14 list the attributes that can with used with the Command element. 
Parameter substitution can be used with the commandLine element as 
described in Using Variables to Access Operations View Data on page 106.

Table 14 Command Attributes and Elements

Attributes and Elements Description

commandLine A required attribute, commandLine defines the command to 
use with a submodule.
Example: 
"commandLine="/usr/sbin/ping hostname 10"

Optional arguments to a command can be placed as part of the 
commandLine attribute.
Be careful when presenting the results of a command. Unless 
configured differently, a command is executed as the user who 
is logged in to the portal server. Ensure that only 
knowledgeable personnel have access to this feature.

type An attribute that indicates what type of output a command 
will generate based on standard MIME types. There are two 
values for this enumerated type:
• text/plain: The output from the command is pure ASCII 

text. In this mode, the HP OpenView Integration portlet 
prefixes the command’s output with the HTML tag <pre> 
and appends the HTML tag </pre> after the command 
completes. This wrapping is necessary to support 
non-HTML output.

• text/html: The output from the command contains HTML 
text. No wrapping of the output is performed.
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expires An attribute that indicates the number of minutes the results 
of command execution are valid. The results of running a 
command are cached if expires is greater than 0 minutes. The 
cached results are used the next time the same command is 
processed until the number of minutes specified in expires 
has elapsed. After the number of minutes has elapsed, the 
HP OpenView Integration portlet reinvokes the command 
instead of using the previous cache. The default is 0 minutes, 
meaning that no caching is performed and the command is 
always executed.

stripHtmlHeader An attribute that is used when the value of type equals "text/
html". This attribute can be set to yes in order to display just 
the contents of the HTML <body> tag. All HTML header 
information from the command is removed from the output 
stream. This attribute may need to be set if the referenced 
command will generate an entire valid HTML document 
including HTML header information. It may not be valid to 
return more than one set of HTML header tags to the browser. 
It is important to remove the additional tags from the 
referenced command. The default value of this attribute is no. 
Possible values: yes|YES|no|NO|0|1.
Output from the portal generates a complete HTML document 
including <Html>, <Head>, and <Body> tags. If the output of 
your command generates its own <Html>, <Head>, and <Body> 
tags, you will have more than one each of the <Html>>, 
<Head>, and <Body> tags. If this is the case, set 
stripHtmlHeader to “yes.”
The default is set to “no” to allow the functioning of any 
potential scripts that you have placed in the <Head> tag. Be 
aware that a document containing multiple <Html>, <Head>, 
and <Body> tags may cause unpredictable behavior in the 
browser. If a problem arises that you suspect is related to 
header data, change StripHtmlHeader to “yes.”

Table 14 Command Attributes and Elements (cont’d)

Attributes and Elements Description
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Url Element Attributes

Table 15 list the attributes that can with used with the URL element. 
Parameter substitution can be used with the href element as described in 
Using Variables to Access Operations View Data on page 106.

Table 15 Url Attributes

 Attributes Description

href A required attribute that defines the URL to use with this 
submodule.
Example: 
href="http://www.hp.com"

Optional arguments to a URL can be placed as part of the href 
attribute.
The default setting for port is 80, and the default protocol is 
http. These are configurable through the URL specified as the 
href for the portlet default XML file or the portlet instance.

displayMethod A required attribute that can be set to either inline, anchor 
or embedded. 
The inline value indicates to Operations View that <IFRAME> 
tags should be used. If you set the attribute to inline and the 
browser does not support inline frames, the browser will 
ignore the <IFRAME> tags and instead present a standard <A> 
tag. Browsers other than IE, including all Netscape browsers 
prior to version 6.0, do not support the <IFRAME> tag.
The anchor value tells the portal to display only a link to the 
specified URL.
The embedded value tells the portal to access the specified 
URL and embed (display) its content into the submodule. 

inlineHeight This attribute applies only if displayMethod="inline". It 
specifies the height, in pixels, that will be provided for an 
inline frame. If not supplied, the default is 100 pixels.

ifNoIFramesMsg This attribute applies only if displayMethod="inline". If the 
client browser does not support inline frames, this text will be 
the name of the link.
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anchorText This attribute indicates the text to display on browsers that do 
not support the <IFRAME> tag, such as versions of Netscape 
that are earlier than 6.0, or when displayMethod is anchor. 
Represents the text to display for a resulting HTML <A> 
anchor tag. The default value is "click here".

proxy An attribute that indicates whether Operations View should 
proxy the data from the specified URL. If proxy="no", then the 
end user’s browser fetches data from the specified location. 
The data should be accessible to the end user. For example, set 
proxy to “no” when displaying user myYahoo account.
If “proxy” equals “yes” then the portal server fetches data 
from the specified location using HTTP request. This allows 
the portal server to directly communicate with another server 
(data source) over a secured network. Use this method to 
access data that are not visible to the end user, for example 
Concord or NNM reports.
If displayMethod="embedded", then proxy is assumed to be 
“yes.”
The default value of “proxy” attribute is “no”. Possible values 
are: yes, no, YES, NO, 0, 1

auth This attribute is used if proxy equals “yes.” 
If proxy is enabled, then the auth attribute is valid; and
• If loginUrl is not set, web server authentication is 

performed, and the “auth” attribute specifies the name and 
password that will be used by the portal server when 
accessing the protected data.

• If loginUrl is set, login page authentication is performed.
The syntax of “auth” for web server authentication requires 
that name and password are separated by a colon. For 
example, auth="name:password"

Table 15 Url Attributes (cont’d)

 Attributes Description
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loginUrl This optional attribute represents a URL to a login page. 
When this is set, and the auth attribute is set, the 
HP OpenView Integration portlet will invoke the loginUrl 
with an HTTP POST, sending the auth string as parameters. In 
this context, the “auth” string contains URL parameters 
rather than a simple "user:password" string as with web 
server authentication. The cookies returned by the web server 
are set when proxying the target URL specified in the href 
attribute. These cookies are also saved on the session and used 
for subsequent invocations of that URL (or its child links).
If proxy is enabled, then the auth attribute is valid; and
• If loginUrl is not set, web server authentication is 

performed.
• If loginUrl is set, login page authentication is performed.
Possible values are: yes, no, YES, NO, 0, 1

handshake This attribute indicates whether the HP OpenView 
Integration portlet should initiate a handshake with a website. 
If handshake is set to “yes” then a handshake is initiated, that 
is, the handshakeUrl is accessed. If any cookie is available in 
the response, the cookie is used when making succeeding 
requests to the website. Handshake only works for web server 
authentication.

handshakeUrl This attribute specifies the URL for the website from which  
the HP OpenView Integration portlet will send and receive 
data. The handshake attribute must be set to “yes”.

windowName This attribute specifies the name of the window into which the 
content should be displayed.

showAsButton This attribute applies only if displayMethod is set to anchor. 
If showAsButton is set to yes, the link is shown as a button at 
the bottom of the portlet rather than a link. The default value 
is no. Possible values are: yes, no, YES, NO, 0, 1

Table 15 Url Attributes (cont’d)

 Attributes Description
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XmlTranslation Element Attributes

Table 16 list the attributes that can with used with the XmlTranslation 
element. Parameter substitution can be used with the xmlHref and xslHref 
elements as described in Using Variables to Access Operations View Data on 
page 106.

Table 16 XmlTranslation Attributes

 Attributes Description

xmlHref A required attribute, xmlHref defines the XML data to display 
through the submodule. This value can be a URL or a file. Use 
URL if the XML data is on the same system or accessible 
through the network. The file path can be absolute (starting 
from the root directory). Alternatively, you can use $CONF_DIR 
to reference files relative to the Operations View installation 
directory. 
Examples:
xmlHref="http://machine.corp.com/myData.xml"
xmlHref="C:/temp/myData.xml"

xslHref A required attribute, xslHref defines the XSL transformation 
to use to display data in the submodule. The XML data 
specified by xmlHref is transformed by XSLT in the xslHref 
attribute and the resulting output is displayed in the portal. 
The value of xslHref can be a URL or a file. Use URL if the 
XSLT resides on a different server. Simply use the file path if 
the XSLT is on the same system or accessible through the 
network. The file path can be absolute (starting from the root 
directory). Alternatively, you can use $CONF_DIR to reference 
files relative to the Operations View installation directory.
Examples:
xslHref="http://machine.corp.com/
topPerformersOfTheDay.xsl"
xslHref="C:/transformations/
topPerformersOfTheDay.xml"

type A required attribute, type is a MIME type of the output 
generated after applying an XSL transformation to XML data. 
For example, type can be set to text/plain or text/html.
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EmbeddedHtml Element Attributes

Table 17 list the attributes that can with used with the EmbeddedHtml 
element.

Table 17 EmbeddedHtml Attributes

 Attributes Description

data The value of this attribute contains HTML for output 
constrained by the conventions outlined in The Embedded 
HTML Content Option on page 103.
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GlobalParms Element Attributes

The GlobalParms element creates a portlet preference that end users can 
modify. For more information, see Making Portlet Preferences User Editable 
on page 109.

Table 18 list the attributes that can with used with the GlobalParms element.

Table 18 GlobalParms Elements

 Element Description

TextParm An optional child element of the GlobalParms element. When 
defined within the GlobalParms element, TextParm element 
defines a parameter that will be applied to all submodules 
within an HP OpenView Integration portlet. The portal 
provides the interface an end user to edit this parameter. (The 
portlet must be editable.)

OptionParm An optional child element of the GlobalParms element. 
OptionParm element defines an option parameter that will be 
applied to all submodules within an HP OpenView Integration 
portlet. The option parameter is a parameter with predefined 
values (options) that a user can choose from. The portal 
provides the interface for a user to choose the value of this 
parameter from the drop-down list. (The portlet must be 
editable.)
The OptionParm element must contain at least one Option 
element.
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TextParm Element Attributes

Table 19 list the attributes that can with used with the TextParm element, a 
child of the GlobalParms element.

Table 19 TextParm Attributes

 Attributes Description

prompt A required attribute. Specifies the prompt for the parameter 
entry. Prompt will be displayed during parameter editing and 
it should clearly identify the parameter for a user.
For example, 
prompt="Host name:" 
prompt="Enter name of NNM station:"

name The required attribute. The name of the parameter. This name 
preceded by the dollar sign $ can be used in fileName, 
commandLine, href, or auth attribute. The portal replaces this 
$name by the parameter value before accessing the file or the 
URL or executing the command.

value The default value of the parameter. The parameter ($name) in 
fileName, href or commandLine will be replaced by this value 
(the value of the value attribute) before accessing the file or 
the URL or executing the command.
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OptionParm Element Attributes

Table 20 list the attributes that can with used with the OptionParm element, 
a child of the GlobalParms element.

Table 20 OptionParm Attrbutes

 Attributes Description

prompt The required attribute. The prompt for the parameter entry. 
Prompt will be displayed during parameter editing and it 
should clearly identify the parameter for a user.
For example, 
prompt="Host name:" 
prompt="Choose name of NNM station:"

name The required attribute. The name of the parameter. This name 
preceded by the dollar sign $ can be used in fileName, 
commandLine, href, or auth attribute. The portal replaces this 
$name by the parameter value before accessing the file or the 
URL or executing the command.

value The name of a default option. The name of an option that 
define the default value of the parameter. The option with this 
name must be defined i.e. Option element with this name 
must be contained in this OptionParm element. 
The parameter ($name) in fileName, commandLine, href, or 
auth will be replaced by the value of this option before 
accessing the file or the URL or executing the command.

Option A child element of OptionParm element. The Option element 
defines one of options for the parameter, that is, one of the 
values that the parameter can take. There must be at least one 
Option element defined (contained in) for an OptionParm 
element.
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Option Element Attributes

Table 21 list the attributes that can with used with the Option element, a 
child of the OptionParm element.

Table 21 Option Attributes

 Attributes Description

name A required attribute of the Option element, specifies the name 
of the option. This name will be displayed in the drop-down 
selection list to identify the option.

value A required attribute of the Option element, specifies the 
default value of the option. If the parameter has this option 
value (that is, if the option is selected), the parameter in 
fileName, href, or commandLine will be replaced by this value 
(the value of the value attribute) before accessing the file or 
URL or executing the command.
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D Tips for Working with Jetspeed 2.1.1 and 
BEA WebLogic 8.1
This appendix contains information that pertains to Apache Jetspeed version 
2.1.1 and BEA WebLogic version 8.1. You might find this information useful 
when configuring and maintaining your portal server. For the most accurate 
information on using Jetspeed, see the Jetspeed portal server documentation. 
For the most accurate information on using BEA WebLogic, see the BEA 
WebLogic portal server documentation.

Using the Default Jetspeed Software

The default portal server provided with HP Operations Dashboard is Jetspeed 
version 2.1.1. This portal server provides some canned demonstrations of 
Operations View portlets and has been branded with an HP Software look and 
feel.

Accessing the default portal server: http://hostname:18080/jetspeed/portal

Administrator user name: admin

Default administrator password: admin

The information in this section is for a third-party product, Apache Jetspeed 
portal server. This product is not developed by Hewlett Packard and may 
change without notice. The information in this appendix is meant to be a 
general introduction to help you be successful using Jetspeed. Other useful 
resources for information on Jetspeed are available at:
http://portals.apache.org/jetspeed-2/guides/index.html
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To launch the default portal server, follow these steps:

1 Open a supported web browser.

2 In the web browser, enter the following URL:

http://hostname:18080/jetspeed

Where hostname is the fully qualified name of the computer on which 
Operations View is installed. If the web browser is running on the same 
computer as Operations View, you can use localhost for the hostname.

18080 is the default port for the Jetspeed portal server. If you changed the 
Jetspeed port number during Operations View installation or by using the 
Operations View Administrator Tool, use the appropriate value in place of 
the default.

3 At the top right of the portal view, log in to the portal server. By default, 
the login information is as follows. Your Jetspeed installation may require 
different login information.

• User name: admin

• Password: admin

If you log in the Jetspeed portal for the first time as the admin user, portal 
server prompts you to change the password as shown in the following 
figure. 

Change the password and click Save.
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Setting Up Users, Roles, and Groups within Jetspeed

The Jetspeed administrator has access to a variety of administrative settings, 
including security for setting up users, roles, and groups. Log in as admin in 
the portal server. The post login screen appears as shown in Figure 17.

Figure 17 Post Login Screen
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Click the Security Administration tab. The Security Administration page 
appears as shown below.

The Security Administration tab provides access to other pages for setting up 
users, roles, groups, constraints, permissions, and SSO management. 

Adding Users

To add a new user in Jetspeed, peform the following steps.

1 Click the User Management tab in the Security Administration screen.

The Security Administration tab appears only if you have logged in as the 
Admin user. No other user, even if the user has been assigned the admin role, 
has permissions to set portal security.
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2 The User Browser and User Detail Information portlets display as shown 
in the following figure. 

These portlets are as follows:

• User Browser: Displays a list of all portal server users. The admin, 
devmgr, and guest users are default users.

• User Detail Information: Allows you to add or remove users and displays 
the details of selected user.
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3 In the User Detail Information portlet, type new user name, password, 
role and other options.
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4 Click Add User. The user is added in the User Browser portlet.

5 You can change the password, role, and group of the user by clicking the 
appropriate link in the User Detail Information portlet.

Adding Roles

To add a new role in the portal server, perform the following steps.

1 Click the Role Management tab in the Security Administration screen.
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2 The Role Admin and Role Detail Information portlets display as shown in 
the following figure. 

These portlets are as follows:

• Role Admin: Displays a list of all roles. The admin, dev, devmgr, guest, and 
user are default roles.

• Role Detail Information: Allows you to add or remove roles and displays 
the details of selected role.
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3 In the Role Detail Information portlet, type new role name and click Save.

4 You can search roles, add users to the role, and remove roles by clicking 
the appropriate buttons in the Role Detail Information portlet.

Adding Groups

To add a new group in the portal server, perform the following steps.

1 Click the Group Management tab in the Security Administration screen.

2 The Group Admin and Group Detail Information portlets display

• Group Admin: Displays a list of all groups. By default, no group is 
available in the portal server.

• Group Detail Information: Allows you to add or remove groups and 
displays the details of selected group.
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3 In the Group Detail Information portlet, type new group name and click 
Save.

4 You can search groups, add users to the group, and remove groups by 
clicking the appropriate buttons in the Group Detail Information portlet.

Constraints

Security constraints are a combination of security permissions. For example, 
you may want to create a new security constraint called users, where you want 
to give view access for all users, and view, and edit access for all admins.

You can use constraints for granting security restrictions to individual pages 
or folders. 

For more information on security constraints, refer the following document:

http://portals.apache.org/jetspeed-2/guides/
guide-security-declarative-psml.html 
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Permissions

You can configure permissions for various Jetspeed entities, such as portlets, 
folders, and pages. You can use this page to assign permissions only to a 
particular set of users or roles for a portlet.

Maintaining Portal Views and the Default Home Page

Portal views within jetspeed are stored in PSML (Portal Structure Markup 
Language) files. Information on PSML files is available from Apache at http:/
/portals.apache.org/jetspeed-2/guides/guide-psml.html. These files 
contain information such as how many tabs are to be displayed, what the tab 
names are, the individual page layouts (one, two, three column), and where 
portlets are to be placed on a page.

To work with PSML files, log in to the portal using the admin user id. 
Navigate the Portal Administration tab -> Portal Site Manager tab. The Portal 
Site Manager appears shown in Figure 18.

Figure 18 Portal Site Manager
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Depending upon the locale of your portal audience, the portal default 
homepage is the PSML file <installdir>/nonOV/dashboard/jetspeed/
2.1/webapps/jetspeed/WEB-INF/pages/default-page.psml. (This file 
might vary depending upon the locales of the portal server. See the Apache 
documentation on PSML locators at http://portals.apache.org/jetspeed-2/
guides/guide-psml.html for information.)
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Creating a New PSML File

To create a new PSML file, follow these steps:

1 Right click HPOperationsDashboard from the portal tree displayed in the 
Portal Site Manager portlet.

2 Select New Page from the popup menu. The Create New Page dialog box 
appears.
209



HP Operations Dashboard Operations View Administrator Guide Version 2.10
3 Type the name, title, and short title for the new PSML page and click 
Create. The new PSML page is added to the portal tree.

4 In the right pane, you can set the following properties of the PSML page.

• Information: enables you to set page decorator, portlet decorator, 
desktop theme and so on.

• Security: enables you to add security constraints to a page.

• Metadata: enables you to add meta data for a page in multiple 
languages.

• Export: enables you to export the PSML file.

5 Click Save.

Portal site manager shows the new page.
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Removing the Demonstration Content

The default PSML homepage file provided contains a tab of Operations View 
Demos. If the admin user locates the default PSML homepage, this entire tab 
(and all content contained within) can be removed. Additionally, you might 
choose to add and/or remove additional content to create a default homepage 
customized for your environment.
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Setting up BEA Portal Security

When creating a portal in BEA WebLogic, there is no login / logout mechanism 
automatically provided. This security mechanism is dependent upon how BEA 
is set up, but there is a sample login portlet that can be used with the default 
BEA security mechanism. This portlet is called the Login Director Portlet.

If you want a secure portal deployment that uses the default BEA security 
mechanism, follow the BEA WebLogic instructions to make the Login Director 
Portlet available to other portlet projects. This information is available at:

http://e-docs.bea.com/workshop/docs81/doc/en/portal/samples/
loginDirector.html

The BEA WebLogic mechanism of granting and denying permission to items 
within the portal is called entitlements. The BEA portal administration tool 
provides a web interface for setting up this configuration, and users should 
consult BEA documentation on Entitlements and BEA portal security 
concepts.

If you do not include any type of portal login mechanism, you will want to 
disable portlet preference editing through BEA entitlements and make sure 
that a filter assignment is set to Allow All Users (Including Anonymous 
Access).
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Glossary
A

access privilege

A permission granted to a principal to perform a specific operation or business 
function. Also called entitlement.

authentication

The process by which a user identifies and validates him/herself to the portal 
server.

authentication provider

A configured component of the portal server that authenticates users who 
attempt to use the system.

authorization

The granting of access privileges to an authenticated user. The granted access 
privileges determine what the user can see and do while logged in to the 
portal server.

B

bookmark

A link to content that can be displayed in a web browser.

bookmark group

A named list of one or more bookmarks.
 213



C

configuration

The combination of software parameters and attributes that determine the 
way the software works, the way it is used, and how it appears.

configuration file

A file that contains specifications or information that can be used for 
determining how a software program should look and operate.

configure

To define and modify specified software settings to fulfill the requirements of a 
specified environment, application, or usage.

customer

An entity (person or organization) that receives services offered by a service 
provider.

customer data filtering 

The use of attributes as a mask for constraining the data that is to be acted 
on, used, or displayed in the user interface. In HP Operations Dashboard 
Operations View, customer data filtering is one aspect of a filter assignment.

customer model

A mapping of customers to resources, where resources are associated hosts, 
interfaces, or services.

customer model source

A configured URL or file that provides the mappings or partial mappings of 
customers to resources.

customize

To design, construct, or modify software to meet the needs and preferences of a 
particular customer or user. For HP Operations Dashboard Operations View, 
customizing is synonymous with assigning to customers what will be 
displayed to them. Operations View customization tasks include customizing 
content, customer filtering, and the setting of options.
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customization 

The process of designing, constructing, or modifying software to meet the 
needs and preferences of a particular customer or user.

D

desktop

A BEA WebLogic term. See portal view.

E

entitlement

A BEA WebLogic term. See access privilege.

extend

The act of increasing the capabilities, scope, or effectiveness of a program. The 
capabilities of HP Operations Dashboard Operations View can be extended 
through the HP OpenView Integration portlet.

extensible

Capable of being extended.

F

filter

A set of attributes and values that act as a pattern or mask through which 
data is passed. Filters allow matching-relevant information to be extracted 
and acted on while non-matching-irrelevant information is blocked.

filter assignment

The security mechanism that defines what data is displayed through the 
portal.
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JDK

Java 2 Software Development Kit. Also called J2SDK.

JAR file

Java archive file. Contains compiled Java classes and the associated data that 
can constitute a program.

JSP

Java server page

JSR168

The technical specification that defines interoperability between portlets and 
portal servers. The HP Operations Dashboard Operations View portlets are 
JSR168-compliant. For more information, refer to the Java Community 
Process website.

JVM

Java virtual machine

M

management station

A computer on which one or more management software products runs.

message

A communication using text and/or images. In HP Operations Dashboard 
Operations View, messages are presented to customers via the Operations 
View Message Board portlet.

message content

The information that is presented in a message. Message content may include 
text and/or graphics.
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navigation aid

A link on a portal page that allows navigation to another portal page. 
Navigation aids can appear as tabs across the top of a portal or as a list along 
the side of a portal. Similar types of portlets can be grouped together and 
accessed from a single navigation aid.

NNM

HP OpenView Network Node Manager

O

operator 

The role of a person who uses a management application to perform a 
specified subset of management tasks.

OVIS 

HP OpenView Internet Services

OVO 

HP OpenView Operations

OVPI 

HP OpenView Performance Insight

OVPM 

HP OpenView Performance Manager

OVR

HP OpenView Reporter

OVSD 

HP OpenView Service Desk
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OVSN

HP OpenView Service Navigator

P

page

A single display or presentation of information on the World Wide Web. 
Typically, a web page consists of an HTML file, referenced graphics files, and 
associated scripts.

PDF 

Portable Document Format

port 

A location for passing information into and out of a network device. 

portal

A web site that provides a variety of different types of information and serves 
as a gateway to other web sites. HP Operations Dashboard Operations View 
provides portlets that can be incorporated into a portal. See portal server 
software.

portlet application

A group of JSR 168-compliant portlets combined with functionality that is 
specific to the target portal server product. Packaged in a WAR file and viewed 
through its portlets. Also called “portal project.”

portal server

The computer that hosts the portal server software.

portal server software

A program that acts as the basic structure to support other software portlets 
or programs that provide additional functionality for the user. HP Operations 
Dashboard requires the use of a supported third-party portal server software 
product.
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portal view

A set of portlets, navigation aids, and view properties within a portal. A portal 
view can be shared by multiple users. A Jetspeed portal view configuration is 
maintained in a PSML file. A BEA WebLogic portal view is called a “desktop.”

portlet

A self-contained software component that performs a specific type of task or 
provides for the presentation of a specific type of data. Portlets can interact 
with one another and with other software. In Operations View, portlets 
present specific sets of functionality to the user through the portal framework. 
Examples of portlets include the Message Board, Service Browser, Network 
Device Health, and the Alarm Portlet.

portlet initialization parameter

A portlet configuration parameter that is set in the Operations View 
Administrator Tool and cannot be changed by portal view users. Each user of a 
given portlet always sees the same results of the portlet initialization 
parameters.

portlet mode

That which determines the operations that are available to a portlet user 
through the portal interface. Operations View supports three distinct portlet 
modes: edit, view, and help. The edit mode allows portlet users to change the 
portlet configuration. The view mode allows portlet users to see the portlet. 
The help mode allows portlet users to access portlet help information.

portlet preference

A portlet configuration parameter that is set in the Operations View 
Administrator Tool and can be modified by portal view users who have the 
edit portlet mode.

PSML

Portal Structure Markup Language. See portal view.
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R

role

That which defines what a user can see and do through the portal at a 
particular point in time. A role can be shared by multiple users.

S

SMART Plug-In (SPI)

Prepackaged software that installs into a management console and provides 
management capabilities specific to a given type of business application, 
database, operating system, or service.

SPI 

See SMART Plug-In (SPI).

SQL 

Structured Query Language

SSL 

Secure Sockets Layer

system administrator 

The role of a person who does configuration and maintenance on a computer 
system or the software on the system.

U

URI 

Uniform Resource Identifier

URL 

Uniform Resource Locator
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user 

A person who uses a software application, a computer or service. A user can 
have one or more roles. For example, a network administrator or operator role.

user preferences

The attributes that are associated with a specific user.

W

WAR file

Web application archive file. A specially structured JAR file that contains the 
functionality to deploy and support a portlet application. Contains the 
web.xml and portlet.xml deployment descriptor files. Might also contain JSPs, 
servlets, and other data.

X

XML 

Extensible Markup Language

XSL 

Extensible Style Sheet Language

XSLT 

Extensible Style Sheet Language Transformations
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Index
A
administration

increasing size of log file, 152
setting logging and tracing, 150
viewing log files, 151

Administrator Tool
connecting management products to 

Operations View, 57

attributes
command, 185
embedded HTML, 191
file, 183
Option, 195
OptionParm, 194
TextParm, 193
TitleBar, 182
URL, 187
XML Translation, 190

authentication
planning, 55

authentication providers
understanding, 34

B
bookmark groups

creating via the Administrator Tool, 82

bookmarks
deleting a bookmarks group, 84
prerequisite to displaying bookmark 

groups through a portal view, 85
understanding, 81

C
cell phones

running SIP, 139

command attributes and elements, 185

commands
xmlvalidate, 153

configuration
wireless SIP, 139

configuring
DISPLAY variable, 58

configuring Operations View
via Administrator Tool, 57

connecting management products to 
Operations View, 57

content
planning portal content, 47
understanding supplied portlets, 155

custom authentication providers
integrating your own, 34

customer data segmentation
planning, 52
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customer model
deleting a customer model source, 126
deleting an organization, 125
developing a custom source, 134
mapping customers to resources, 121
understanding customer data 

segmentation, 119
using an external customer model, 119
using Operations View customer model, 

119

customer model sources
developing a custom source, 134
understanding, 36

D
data

segmenting for customers, 52
understanding customer data 

segmentation, 119

data filtering, 35

data filters
deleting a filter assignment, 130
deleting a filter assignment package, 131

DISPLAY variable, 58

documentation
HP Operations Dashboard, 15

E
elements

command, 185
Generic, 180
Submodule, 180

embedded HTML attributes, 191

F
features

data filtering, 35
HP OpenView Integration portlet, 98
wireless environments, 139

file attributes, 183

filtering data, 35
segmenting customer data, 52

G
Generic element, 180

H
help

adding and customizing, 76

HP OpenView
presenting information from 

HP OpenView management 
products, 159

HP OpenView Integration portlet
features, 98

HP Operations Dashboard
documentation, 15

HP-UX
DISPLAY variable, 58

I
I18N

model, 38

Integration portlet
adding online help, 76

internationalization of Operations View, 38
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L
log file

increasing the size, 152
viewing, 151

logging and tracing, 150

M
management data filtering

understanding, 35

management products
connecting to Operations View, 57

mapping customers to resources, 119, 121

message board messages
changing the content, 90
configuring, 88
creating via Administrator Tool, 89
creating via the Administrator Tool, 82
deleting, 91
removing from a portal view via the 

Administrator Tool, 86, 93, 133

N
NNM

portlets’ use of customer model, 119

O
online help

adding and customizing, 76
assigning a topic as the default help 

topic for a portlet, 77
writing a help topic, 76

OpenView
connecting management products to 

Operations View, 57

Option attributes, 195

OptionParm attributes, 194

OVIS
portlet’s use of customer model, 119

OVO
portlet’s use of customer model, 119

OVPI
portlets’ use of customer model, 120

OVSD
portlets’ use of customer model, 119

OVSN
portlets’ use of customer model, 119

P
PDAs

running SIP, 139

portals
planning roles, 50
planning the content, 47
security, 34

portal view, 29

portal views
understanding, 29

portlets
bookmarks portlet, 81, 160
customizing online help for, 76
displaying segmented customer data 

through, 119
message board portlet, 87, 160
presenting data from HP OpenView 

products, 159
supplied with Operations View, 155

R
role configurations

planning, 50

roles
planning, 50
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S
segmentation of customer data

planning, 52
understanding, 119

Submodule elements, 180

T
TextParm attributes, 193

TitleBar attributes, 182

troubleshooting
setting portal logging and tracing, 150

U
URL attributes, 187

user and role configurations
planning, 55

V
variable

DISPLAY, 58

W
wireless environments

configuring SIP to run wireless, 139

X
XML files

validating, 153

XML Translation attributes, 190

xmlvalidate command, 153
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